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98 年度政府部門科技計畫期末摘要報告 

計畫名稱： 探空及遙測資料校正技術在中尺度天氣系統分析與預報

技術之應用 
審議編號： x 部會署原計畫編號： MOTC-CWB-98-2

M-06 

主管機關： 交通部中央氣象局 執行單位： 中國文化大學 

計畫主持人： 劉清煌 聯絡人： 劉清煌 

電話號碼： 0919-094520 傳真號碼： (02)28615274 

期程： 98 年 1 月 21 日至 98 年 12 月 31 日 

經費：（全程）      888     仟元 經費(年度)      888  仟元 

 

執行情形： 

1.執行進度： 

 預定（％） 實際（％） 比較（％） 

當年 100 100 0 

全程 100 100 0 

 

2.經費支用： 

 預定 實際 支用率（％）

當年 355200 355200 100.0 

全程 888000 608090 68.5 
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3.計畫執行概況： 

  下圖為預定進度甘梯圖（Gantt Chart），至目前為止，皆按原計畫進行中無落後。 

 

 

期中報告於 6 月 25 日假中央氣象局衛星中心會議室完成，期中預計完成的項目有： 

  （1）探空資料蒐集與整理。 

  （2）資料格式整合並使用 ASPEN QC。 

  （3）人工檢視及列表。 

這些工作均已如期完成，審查委員亦根據期中報告內容給予建議如下，Part A 為修正後之

期中報告： 

  （1）加入 Version1 探空品質控管程序之流程圖。 

  （2）詳細說明流程圖中的每一步驟，並列表統計 Questionable 與 Bad 的比例。 

  （3）加入 ASPEN 軟體濾除之可疑資料點以及主觀認定為 Questionable 及 Bad 之

例圖。 

  回覆：V1 品質控管程序詳述於 Part A 中的第六部分（第 11 頁~第 14 頁）。圖 2 為

V1 品質控管流程圖，首先藉由探空直接測量之各變數的垂直剖線圖來檢視探

空資料的品質（圖 3），以主觀目視法對所有的探空資料進行檢驗，人工判斷

資料是否有所缺失、所繪出的垂直剖線曲線是否合理，以及資料曲線變動
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(fluctuation)是否太大等，藉此來檢查資料的系統性誤差以及個別探空資料的

問題，表 2 即為利用主觀識別法所統計出 Questionable 與 Bad 的資料筆數。

接著，先將資料內差至 5-hPa，再利用客觀統計的方法來評估資料的品質，表

3 即為經過客觀統計法對探空資料做品質評估得到的結果。最後，根據斜溫圖

進一步檢視每一筆探空資料的狀況，斜溫圖可以協助我們找出受到其他污染的

探空資料，如圖 5 所示。  

  （4）將 NCAR ASPEN 使用者手冊置於期末報告之附錄中。 

  回覆：Part C 即為 NCAR ASPEN 使用者手冊。 

 

期末報告於 12 月 7 日假中央氣象局衛星中心會議室完成，期末預計完成的項目有： 

  （1）利用 GPS 或衛星反演出的可降水量（PW）來檢驗探空資料的溼度偏差。 

  （2）分析校驗比對資料，確認不同類型探空儀是否需要校正。 

  （3）探空資料校正方法研究與分析。 

這些工作亦如期完成，審查委員給予之建議如下： 

  （1）圖表解說需配合，部分圖表的 scale 不一致需改善。 

  回覆：已修正原第 10 頁圖 4 左右兩張圖的 Scale 不同之問題，修改後的圖置於本報

告第 13 頁圖 4。 

  （2）詳細說明 CDF 配對法。 

  回覆：CDF 配對法之詳細說明以添加於 Part Ｂ的第四部分（第 43 頁）。 

  （3）在計算累積頻率分布時，加入在不同溫度與溼度區間下的總資料筆數。 

  回覆：表 4 即為在不同溫度與溼度區間下可用來執行 CDF 配對法的資料筆數（第 41

頁）。 

  （4）比較 NCAR ASPEN 與 CWB 現行作業上使用之 QC 程序。 

  回覆：NCAR ASPEN QC 程序位於 Part A 的第三部分（第 7 頁～第 8 頁），而目前

中央氣象局作業上的 QC 程序詳列於 Part A 的第四部份（第 9 頁）中。 

  （5）比較不同種類探空儀的特性。 

  回覆：於實驗開始前，計畫辦公室曾於板橋進行為期 2 天的 intercomparison 比對實

驗，Graw、Vaisala RS-92 與 Meisei 一起升空，所以我們可以清楚的看到三

種不同探空儀的特性，圖 17 即為其中兩顆探空的不同參數的垂直剖面圖（第

50 頁～第 51 頁）。 

 

4.期末主要執行成果如 Part B（第 33 頁～第 47 頁）所示。 
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Part A 
 

期中報告 
 

探空資料庫概述與品質控

管（QC）程序 
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前言： 

 期中報告前的工作主要是針對 SoWMEX 實驗期間（2008 年 5, 6 月）所收集到的探

空資料進行資料品質的分析，並起著手準備探空資料的校正工作。 

 

一、資料庫綜述： 

  SoWMEX 實驗期間（2008 年 5, 6 月）的加強探空網是由 13 個地面探空站以及在洋

面上進行 15 次飛行任務的投落送所組成（圖 1），主要的觀測發生在 5/15~6/26 間。表

1 總結了各個測站的位置以及其他相關資訊。這些探空站皆為高時間解析度（0.5-10s）

的探空資料，分為六種不同格式，這些不同格式的原始資料會先轉換成一種共用的格式－

NCAR ASPEN D-glass，這些 D-glass 檔經過 ASPEN 軟體對資料進行 QC 後會輸出成

EOL 格式的檔案， EOL 格式將於第二節中介紹。 

 

 

圖 1 SoWMEX 實驗期間之探空網，圓圈內填色則代表不同的探空儀系統，此外，中國的

探空站不包含在 SoWMEX 的加強探空網中。 

 

 

 

 



 6

表 1 SoWMEX/TiMREX 實驗期間各探空站之相關資訊。*代表研究船在名義上的位置。

MS80 表示 Meisei RS80 系統，VS 為 Vaisala 系統；風場的測量則是自動追蹤無線

電經緯儀 (Automatic Tracking Radiotheodolite，ATR)或全球定位系統 (Global 

Positioning System，GPS)。 

測站站碼 測站名稱 系統類型 緯度 經度 高度

(m) 

解析度

(s) 

探空筆數 日期 

46692 Banchiao MS 80-ATR 25.00 121.43 11 5 184 5/16-6/25

46699 Hualien VS 80-ATR 23.98 121.61 19 2 185 5/15-6/25

46734 Makung VS 80-ATR 23.56 119.63 34 2 232 5/15-6/26

46741 Tainan MS 80-ATR 23.04 120.23 8 5 76 5/27-6/06

“ “ VS 92-GPS 23.04 120.24 15 1 53 6/12-6/23

46750 Pingdong VS 80-ATR 22.69 120.47 27 2 248 5/15-6/26

“ “ VS 92-ATR “ “ “ “ 18 6/3-610 

46780 Lu-Tao VS 80-ATR 22.65 121.48 252 2 201 5/16-6/21

“ “ VS 92-GPS “ “ “ “ 18 6/22-6/26

46810 Dongsha Is. MS 80-ATR 20.70 116.72 4 5 156 5/07-6/25

“ “ VS-92-ATR “ “ “ 2 1 6/10 

98223 Laoag, Phil. Graw-GPS 18.18 120.53 5 10 67 5/15-6/30

99692 N. Ship VS 92-GPS 26.3* 122.0* 6 2 46 5/30-6/10

99744 Liou-Guei VS 92-GPS 22.99 120.64 266 1 218 5/14-6/26

99759 Henchun VS 92-GPS 22.01 120.74 24 1 140 5/14-6/26

99770 Taichung VS 92-GPS 24.25 120.60 202 2 163 5/15-6/17

99810 SW Ship Graw-GPS 22.0* 119.0* 3 1 134 5/14-6/21

 dropsondes Vaisala-GPS    0.5 190 5/02-6/25

total       2330  

 

 

二、資料格式說明： 

  所有 D-glass 檔案格式的探空資料經過 ASPEN QC 後將會被輸出成 UCAR/JOSS 

(University Corporation for Atmospheric Research/Joint Office for Science Support) 

EOL (Earth Observing Lab) 格 式 ， 這 些 檔 案 的 命 名 規 則 為 "D 

yyyymmddhh_stnid.QC.eol"，D 代表此檔案為 D-glass 轉換而來，年、月、日分別以 yyyy、

mm、dd 表示，hh 為世界標準時，(UTC)，stnid 是測站站碼(如表 1 所示)，eol 則代表檔

案格式類型。EOL 格式為 ASCII 格式的一種，包含檔頭以及 17 欄高解析度的探空資料。

前 14 行為檔頭，包含資料類型、計畫名稱、探空站位置、氣球釋放時間和其他詳細的資

訊。第 5 行表示釋放地點，其格式為：經度 (deg min)、經度 (dec. deg)、緯度 (deg min)、

緯度 (dec. deg)、高度 (meters)。以 dec min 表示經度的格式為：ddd mm.mm'W，ddd
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為度、mm.mm 為分、W 和 E 代表西經及東經。緯度和經度有相同的格式，除了 S 和 N

表示南、北緯。8~10 行包含機載資料、輔助資訊和注釋；第 12 行為參數名稱、第 13 行

為單位、第 14 行用虛線來表示檔頭的結束。檔頭後即為詳細的探空資料，17 個欄位所代

表的參數場如下表所示： 

 
Field Parameter    Units   Measured/Calculated 
 No.  
 
 1 Time                   Seconds             ------------- 
 2  UTC Hour               Hours               ------------- 
 3 UTC Minute             Minutes              ------------- 
 4 UTC Second            Seconds             ------------- 
 5 Pressure          Millibars           Measured 
 6 Dry-bulb Temp           Degrees C           Measured 
 7 Dewpoint Temp          Degrees C           Calculated 
 8 Relative Humidity         Percent           Measured 
 9 U Wind Component  Meters/Second        Calculated 
 10 V Wind Component  Meters/Second        Calculated 
 11 Wind Speed       Meters/Second      Measured 
 12 Wind Direction           Degrees              Measured 
 13 Ascension Rate          Meters/Second      Calculated 
 14 Geopotential Altitude  Meters               Calculated 
 15 Longitude        Degrees           Measured 
 16 Latitude           Degrees           Measured 
 17 GPS Altitude          Meters               Measured 
 
這邊要注意的是 upsondes 沒有 GPS 高度，所以此欄位設定為-999。 

 

三、UCAR/JOSS 品質控管程序 (Quality Control Processing)： 

 
  此資料庫經過一自動化的 QC 程序，要注意的是熱力場(溫度與露點)與風場將分開進

行，此程序主要包含兩種內部一致性的檢驗：對所有參數進行概括性檢驗(gross limit 

check)和對溫度、氣壓和上升速度進行垂直遞減率檢驗。更進一步地 QC 程序資訊能在

Loehrer et al. (1996)和 Loehrer et al. (1998)的文章中找到。 

 

1. Gross Limit Checks： 

  此檢驗將會把每一筆標註為 Bad 的探空資料設成遺失值，檢驗標準如下表所示，P

為氣壓、T 為溫度、RH 為相對溼度、U 是東西風分量、V 是南北風分量，B 代表 Bad、

Q 代表 Questionable。 
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Parameter Parameters(s) 
Gross Limit Check 

Flag 
Flagged

Applied 

    
Pressure < 0 mb or > 1050 mb P B 
Altitude < 0 m  or > 40000 m P, T, RH Q 

Temperature < -90C or > 45C T Q 
Dew Point < -99.9C or > 33C 

> Temperature 
RH 

T,RH 
Q 
Q 

Relative 
Humidity 

< 0% or > 100% RH B 

Wind Speed < 0 m/s or > 100 m/s 
> 150 m/s 

U,V 
U,V 

Q 
B 

U Wind 
Component 

< 0 m/s or > 100 m/s 
> 150 m/s 

U 
U 

Q 
B 

V Wind 
Component 

< 0 m/s or > 100 m/s 
> 150 m/s 

V 
V 

Q 
B 

Wind Direction < 0 deg or > 360 deg U,V B 
Ascent Rate < -10 m/s or > 10 m/s P,T,RH Q 

      

2. 垂直一致性檢驗（Vertical Consistency Checks）： 

  此檢驗從最低層開始，並且比較鄰近的資料點 (但是當氣壓小於 100mb 時，則使用

30 秒的平均值)，在檢查時必需要確保資料數值的增加或減少合乎預期，否則需標註成

-999。 

 
Parameter Vertical Consistency Check Parameter(

s) 
Flagged 

Flag 
Applied

    
Time decreasing/equal None None 

Altitude decreasing/equal P,T,RH Q 
Pressure increasing/equal 

> 1 mb/s or < -1 mb/s 

> 2 mb/s or < -2 mb/s 

P,T,RH 
P,T,RH 

P,T,RH 

Q 
Q 

B 

Temperature < -15 C/km 
< -30 C/km (not applied at p < 250 mb) 

> 50 C/km (not applied at p < 250 mb) 

> 100 C/km (not applied at p < 250 mb)

P,T,RH 
P,T,RH 

P,T,RH 

P,T,RH 

Q 
B 

Q 

B 

Ascent Rate Change of > 3 m/s or < -3 m/s 
Change of > 5 m/s or < -5 m/s 

P 
P 

Q 
B 
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四、CWB 現行作業上的 QC 程序： 

  CWB 的 QC 程序由氣象局資訊中心張庭槐先生提供，主要可分為兩類，： 

（一）解碼檢驗條件：檢定方法的各個項目： 

  (1) 尾差參數的計算和標準化： 

    用來計算觀測資料的各項尾差值並加以標準化：包括增量值尾差、垂直統計尾

差、靜力平衡尾差、基線尾差、降溫率檢驗、水平統計尾差、尾差值標準化。 

  (2) 資料型態的設定 (Surface Layer Type)： 

    利用探空資料高度場與溫度場是否齊全和各標準層間彼此之相對位置，分類出

13 種資料型態。 

  (3) 資料誤差型態的設定： 

    探空資料的誤差型態可分成通訊誤差、計算誤差及觀測誤差。針對不同的資料層

型態歸納出七種不同的資料誤差型態。 

(4) 資料層型態產生誤差型態的判斷： 

    依據不同資料型態之誤差型態，進行誤差判斷。 

  (5) 誤差型態之錯誤修正程序 

   1. 根據不同誤差型態計算其錯誤修正值。 

   2. 利用各種尾差和這些尾差標準差統計資料做權重平均，可得一最佳修正值。 

   3. 如果錯誤修正值和最佳修正值十分接近時，則用錯誤修正值做簡單修正，簡單

修正的方法為利用正負號交換、更改一個數字、兩個數字調換或是上述方法的

組合。 

   4. 若錯誤修正值和最佳修正值差距很大時，則用此最佳修正值做簡單修正。 

   5. 檢驗是否所有的尾差值都變小，若尾差值沒有變小，則標示此資料是有錯誤

的。
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（二）模式輸入檢驗條件： 

 

Parameter Error Value  

Pressure 100 Pa  

Wind Speed 1.1~3.3~2.7 (m/s) 隨高度遞增直到 200 hPa 達最大後就開始遞減

Wind Direction 5°  

Height 7~59.3 (m) 隨高度遞增 

Temperature 1℃  

Dew Point 1℃  

Relative Humidity 10%  

   

模式頂為 30 hPa   

   

在 WRFVAR 中，O – B > 5 * (Error Value)為主要的 QC 門檻值 

其中，B 為背景值（First Guess），O 為觀測值。 

 

 
 

五、資料檔案詳述以及重要注記： 

  探空資料的時間解析度為 0.5-10 秒，氣壓、溫度和相對溼度為直接量測量；露點溫

度是由相對溼度計算而來；高度則將氣壓、溫度和露點溫度代入靜力方程中得出；上升速

度是由連續兩個時間的高度差異來取得；位置／地點則是用水平風與初始釋放位置來計

算。由於氣球下方之探空儀呈鐘擺運動，所以原始風場已經使用一濾波器來移除低頻震

盪。另外，每個探空第一筆資料的時間為-1.0 秒，表示資料是由獨立的地面氣象站而來，

在 QC 程序中，此資料被當成參考值來決定探空儀氣壓、溫度和相對溼度測量的準確度。 
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六、品質控管與探空品質的初步評估：  

  圖 2 為探空資料品質控管（QC）流程圖，此品質控管流程主要分成三大部份： 

 

 
圖 2 探空資料品質控管（QC）流程圖 

 

  首先藉由探空直接測量之各變數的垂直剖線圖(variable line plot diagram)來檢視探

空資料的品質（圖 3），對所有的探空資料進行檢驗，在此主要是主觀的由人工檢查資料

是否有所缺失、所繪出的垂直剖線曲線是否合理，以及資料曲線變動(fluctuation)是否太

大等，藉此來檢查資料的系統性誤差以及個別探空資料的問題，表 2 即為利用主觀識別法

所統計出 Questionable 與 Bad 的資料筆數。若該筆探空資料被判斷成有問題，找出並記

錄該筆探空之探空儀序號(Serial Numbers)及當時之工作日誌，列表儲存。 

利用主觀識別法檢驗每顆探空 

紀錄到錯誤清單中 NCAR ASPEN QC 

利用skewT-logP 圖再次檢驗 

Good Questionable + Bad 

Version 1 

統計檢驗 

客觀識別法 
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圖 3 利用主觀識別法來檢視探空資料的品質。 

 

表 2 主觀判斷各探空站探空資料有問題之筆數統計。 

測站名稱與站碼 系統類型與探空儀型號 探空個數 有問題的探空 (筆 / %) 

花蓮 (46699) Vaisala RS-80 185 16 / 8.7 

馬公 (46734) Vaisala RS-80 232 18 / 7.8 

屏東 (46750) Vaisala RS-80 248 21 / 8.5 

綠島 (46780) Vaisala RS-80 219 21 / 9.6 

板橋 (46692) Meisei 184 9 / 4.9 

東沙 (46810) Meisei 156 56 / 35.9 

台南 (46741) Meisei &Vaisala RS-92 129 9 / 7.0 

六龜 (99744) Vaisala RS-92 218 10 / 4.6 

恆春 (99759) Vaisala RS-92 140 4 / 2.9 

台中 (99770) Vaisala RS-92 163 18 / 11.0 

佬沃, 菲律賓 (98223 ) Graw 67 2 / 3.0 

南船 (99810) Graw 134 25 / 18.7 

北船 (99692) Vaisala RS-92 46 3 / 6.5 

投落送 Vaisala RSS903 190 30 / 6.4 

 

  經過此步驟後，我們已經對於探空資料品質有大致上的輪廓，而後我們將探空資料利

用 NCAR ASPEN 進行品質控管的程序，為了盡可能保留所有探空資訊，不論該筆資料是

否被判定為有問題，所有的探空資料都會進到 NCAR ASPEN 做品質控管的動作。原始
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D-glass 資料經過 ASPEN (Atmospheric Sounding Processing ENvironment)  QC 後不

僅能讓資料更平滑，更能移除可疑的資料點（圖 4）。 

 

 
圖 4 NCAR ASPEN 品質控管程序，左圖為探空之原始資料，右圖為經過 ASPEN 品質控

管後，已濾除可疑的資料點（黑色方框）。 

 

  接著，我們將利用客觀統計的方法來評估資料的品質，先將資料內差至 5-hPa，再計

算每一層、不同參數的時間平均，然後將實際觀測值與此平均值相比，若是介於 3-6 個標

準差歸類成 Q，大於 6 個標準差則為 B，表 3 即為經過客觀統計法對探空資料做品質評估

得到的結果。 

 

表 3 客觀統計法之探空資料品質評估。 

Site ID System type Sondes (#)

Quality 

T 

Q, B (%)

Quality 

Td 

Q, B (%) 

Quality 

Winds 

Q, B (%) 

花蓮 (46699) Vaisala RS-80 185 11.4, 0 24.3, 1.1 13.5, 2.2

馬公 (46734) Vaisala RS-80 232 11.6, 0 27.6, 0.9 9.5, 3.0 

屏東 (46750) Vaisala RS-80 248 13.7, 0 21.4, 1.2 12.5, 1.6

綠島 (46780) Vaisala RS-80 219 15.5, 0 24.2, 1.4 12.8, 2.3

板橋 (46692) Meisei 184 14.7, 1.6 22.8, 2.7 36.4, 4.9

東沙 (46810) Meisei 156 9.6, 1.3 15.4, 2.6 22.4, 10.3

台南 (46741) Meisei &Vaisala RS-92 129 5.4, 1.6 15.5, 2.3 16.3, 2.3

Raw Data ASPEN QC’ed 
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北船 (99692) Vaisala RS-92 46 13.0, 0 26.1, 0 2.2, 0 

六龜 (99744) Vaisala RS-92 218 17.9, 0 19.7, 3.2 11.5, 0 

恆春 (99759) Vaisala RS-92 140 20.7, 0 15.7, 2.1 10.0, 0 

台中 (99770) Vaisala RS-92 163 11.0, 0.6 25.6, 4.3 17.7, 1.2

南船 (99810) Graw 134 17.2, 0.7 12.7, 3.7 6.7, 0 

佬沃，菲律賓 (98223 ) Graw 67 6.0, 1.5 16.4, 1.5 13.4, 1.5

Total 2121 13.4, 0.5 21.1, 2.1 14.9, 2.4

 

  最後，根據斜溫圖進一步檢視每一筆探空資料的狀況，斜溫圖可以協助我們找出受到

其他污染的探空資料，如圖 5 所示，在 500~600 hPa 處受到對流污染，使得溫度與露點

溫度同時不正常下降與上升。所有的 V1 品質控管過程到此就告一段落，圖 6 為 V1 最後

的初步評估結果，VS92 的在熱力及動力場的表現皆相當不錯，除了台中站有較雜亂的風

場分布，這需更多的分析資料來分析。 

 

 
圖 5 台南站 2008 年 6 月 4 日 0300UTC 之斜溫圖，為 Meisei 探空儀。 

 

受到對流污染!!!非正確之觀測值
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圖 6 V1 探空資料的初步評估。長條狀上方的數字代表有問題與錯誤資料所佔的百分比。 

 

  Version 1 探空資料的初步評估總結於下表，此表僅代表資料可能有問題 

(questionable)或是錯誤的 (bad)，我們無法保證這個清單已經很完美了，但是，較嚴重

的問題也幾乎都已經確定，每個使用者可自行決定要如何看待這些可能有問題的數據。

表中，若是該筆探空資料在任何層有出現 Questionable (那也就是說資料看起來是可疑

地)，那麼 Q 將計數乙次；若是出現 Bad (也就是稍微懷疑資料是錯誤地)，將計為 B 而不

是 Q；q dif 表示地面的比溼減去探空第一筆量測到的比溼之平均差異。 

 

測站站碼 測站名稱 系統類型 資料品質 

T,Td 

Q, B 

資料品質

Winds 

Q, B 

q_dif 探空數目

46692 Banchiao MS 80-ATR 20, 12 20, 6 0.23 184 

46699 Hualien VS 80-ATR 4, 0 3, 2 2.58 185 

46734 Makung VS 80-ATR 2, 0 14, 4 3.08 232 

46741 Tainan MS 80-ATR 2, 3 7, 4 0.54 76 

“ “ VS 92-GPS 0, 0 0, 0 0.54 53 
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46750 Pingdong VS 80-ATR 4, 0 12, 4 2.51 248 

“ “ VS92-GPS 0,0 0,0 1.53 18 

46780 Lu-Tao VS 80-ATR 1, 0 8, 6 2.57 201 

“ “ VS92-GPS 0,0 0,0 -0.09 18 

46810 Dongsha Is. MS 80-ATR 10, 5 13, 51 0.82 156 

“ “ VS92 0,0 0,0 2.31 1 

98223 Laoag, Phil. Graw-GPS 1, 2 1, 0 1.47 67 

99692 N. Ship VS 92-GPS 4, 0 0, 0 0.50 46 

99744 Liou-Guei VS 92-GPS 1, 0 1, 0 -0.45 218 

99759 Henchun VS 92-GPS 0, 0 0, 0 0.51 140 

99770 Taichung VS 92-GPS 6,4 21, 24 0.10 163 

99810 SW Ship Graw-GPS 2, 3 0, 0 0.51 134 

 dropsondes Vaisala-GPS 4,6  2, 1 -0.02 190 

total   59, 35 103, 102  2330 

 

Version 1 的初步結論如下： 

(1) 首先，品質評估是利用目視法檢查斜溫圖、時間序列及散佈圖來主觀決定。有問題

或錯誤的測定建議有一個確定性的判斷，一般來說，從時間平均來看，介於 3-6 個

標準差歸類成 Q，大於 6 個標準差則為 B。 

(2) 在大多數個案中，錯誤或有問題的資料通常發生在有限的垂直層，其餘的探空資料

仍然是有用的。 

(3) 板橋及東沙為 Meisei 系統，結果顯示有較差的成績，特別是在 300 hPa 以上，RH

隨高度時常為接近一常數，因此，需小心使用。 

(4) Vaisala RS80（VS80）系統存在較大的 q_dif，這表示 dry bias 存在且需要更進一

步進行溼度校正，此校正將在 version 2 中完成。 

(5) 當溫度資料在某些層為錯誤或有問題時，在一定程度上也會影響到重力位高度。 

(6) 許多有問題或是錯誤的探空可能是因為強對流在探空儀附近，這將使環境有較大的

擾動存在，在這種情況下，探空並無法代表中尺度或大尺度環境場，應謹慎小心使

用。 

更詳細的分析則紀錄於下。 
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46692（板橋）之初步品質控管評估 

 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料，TO 表示該筆探空的錯誤或有問題資料存在

於整個探空剖面，SA 表示超絕熱層。 

 

Wind QC  (46692) 
Date Time Level  

  GMT (hPa)  

05/19  06   200-300  

05/19  18  < 250  

05/24   06  ~900  

05/29   12  ~950   

05/30  03  ~950 

05/29 09  ~900     

06/01 15  150-200 

06/01 21  250-275 

06/03 06  100-150 

06/03 12  ~150 

06/03 18  125-200 

06/04 09  ~150 

06/04 12  ~150 

06/05 15  ~100 

06/05 18  ~250 

06/11 00  200-950 

06/11 06  200-900 

06/11 12  TO 

06/12 00  TO 

06/12 12  ~150 

06/13 18  ~550 

06/14 00  150-600 

06/14 06  150-350 

06/14 12  < 600 

06/17 06  ~250 

06/22 00  750-850 

T,Td QC   (46692) 
Date    Time    Level  
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         GMT    (hPa)  

05/18     00     ~990 SA 

05/21     06      ~525  SA 

05/23     06      500-600  SA 

05/23    12      ~725  SA 

05/26    06      near sfc SA 

05/26    18     ~950  SA 

05/27    00     ~950  SA 

05/29    12     ~940  SA 

05/30    00     ~990 SA 

05/30    12      450-600  

06/02    03     ~950 SA 

06/02    09     ~400 SA 

06/02    18     ~460 

06/02    21      > 500 

06/04    06      ~1000 SA 

06/06    00      ~530 SA 

06/10    06      ~670 SA 

06/11    00      ~900 

06/12    00      ~1000, too cold TO 

06/12    12      ~400 

06/13    00      >950 

06/14    00      >950 

06/14    18      ~975 

06/15    12      ~850 SA 

06/17    06      > 950 

06/18    00       ~975 

06/19    03       near sfc  SA 

06/19    12       ~925 SA 

06/20    00       > 950 

06/20    03       850-sfc SA 

06/21    12       near sfc SA 

06/25    06       near sfc, 850 SA, < 150 too warm 

 

Notes：此探空系統易於發生超絕熱（Super Adiabatic，SA）層（也就是遞減率>乾絕熱）。

而超絕熱層常發生在日間之陸地上近地面處，這邊提到的超絕熱稍高於地面或在雲層上

方。當探空儀位於雲內，附著在溫度感應器上的水蒸發造成感應器過度冷卻（6/10 06Z

為一個相當好的例子）。
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46699（花蓮）之初步品質控管評估 

 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料，TO 表示該筆探空的錯誤或有問題資料存在

於整個探空剖面。 

 

Wind QC  (46699) 
Date    Time    Level  

   GMT    (hPa)  

05/17     18       <220 

06/03     15       <440 

06/06     15       600-800 

06/15     12       ~850, ~250 

06/17     12        ~500 

 

T,Td QC  (46699) 
Date    Time    Level  

  GMT    (hPa)  

05/21    18       near sfc 

05/22    06       sfc  

05/31    00       > 750 

06/01    00       sfc T,  heights too low 

  

 

 

Notes：本站使用 VS80 探空儀，Version 1 的資料有顯著的 dry bias，此 bias 將在 Version 

2 中被校正。 
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46734（馬公）之初步品質控管評估 

 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料，TO 表示該筆探空的錯誤或有問題資料存在

於整個探空剖面。 

 

Wind QC  (46734) 
Date    Time    Level  

  GMT    (hPa)  

05/16      00     < 250 

05/19      09      < 250 

05/19     12       > 850 

05/30      21      TO 

05/31      18      < 250 

06/01      15      < 900 

06/01      18      < 350 

06/03      12       TO 

06/03      15        < 450 

06/05      09       < 400 

06/06      09       500-900 

06/06      18       750-950 

06/14      15       ~950 

06/15      06       ~950 

06/16      12       < 150 

06/17      09       150-250 

06/18      18       < 200 

06/23      06       TO 

  

T,Td QC  (46734) 
Date    Time    Level  

  GMT    (hPa)  

05/19    00      too cool at low levels        

06/17    03      ~600        

 

Notes：本站使用 VS80 探空儀，Version 1 的資料有顯著的 dry bias，此 bias 將在 Version 

2 中被校正。 
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46741（台南）之初步品質控管評估 

 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料，TO 表示該筆探空的錯誤或有問題資料存在

於整個探空剖面。 

 

Wind QC  (46741) 
Date    Time    Level  

  GMT    (hPa)  

 05/27    06        ~950  

05/30    06        ~780  

05/30    21        900-1000  

06/02    00         < 400   

06/03    00         ~550 

06/03    03         > 900 

06/04    03        ~550 

06/04    06         >800 

06/05    03         ~300 

06/05    06         ~250 

06/06    12         >900 

 

T,Td QC  (46741) 
Date    Time    Level  

  GMT    (hPa)  

06/02     00       500-600 

06/02     03       400-750 

06/03     00       400-600  

06/04     03       500-600 

06/06     00        TO  

 

Notes：5/27-6/6 使用 Meisei 系統，6/12-6/23 則使用 Vaisala RS92，RS92 的探空將可

能需要需要日間 dry bias 的校正。多數有問題和錯誤的資料可能是由於在對流附近施放。
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46750（屏東）之初步品質控管評估 

 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料，TO 表示該筆探空的錯誤或有問題資料存在

於整個探空剖面，SA 表示超絕熱層。 

 

Wind QC  (46750) 
Date    Time    Level  

  GMT    (hPa)  

05/16      18     200-800 

05/18      18     125-700 

05/31      18      800-1000 

06/02      00      ~ 800 

06/02      09      800-1000 

06/03      21       800-900 

06/04      00       800-900 

06/04      18       ~350, < 200 

06/05      12       < 650 

06/05      15       < 500 

06/07      06        < 500 

06/08      00       < 700 

06/13      18       < 200 

06/14      03       > 900 

06/14      09        ~ 400 

06/16      09        ~ 500 

  

T,Td QC  (46750) 
Date    Time    Level  

  GMT    (hPa)  

05/29     00      ~ 550 

05/30     21       450-500 SA 

06/05     00       sfc – 980  

06/14     18       550-850  

 

Notes：本站使用 VS80 探空儀，Version 1 的資料有顯著的 dry bias，此 bias 將在 Version 

2 中被校正。 
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46780（綠島）之初步品質控管評估 

 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料，TO 表示該筆探空的錯誤或有問題資料存在

於整個探空剖面。 

 

Wind QC  (46780) 
Date    Time    Level  

  GMT    (hPa)  

05/17      06       200-600  

05/18      06       < 650  

05/20      12        200-750  

05/23      12        ~ 450 

05/25      00        550-850 

05/28      18        550-1000 

05/28      18        ~ 1000 

05/30      21        TO 

06/01      03         ~ 800 

06/04      00        300-1000 

06/10      18         TO 

06/11      00        ~ 1000 

06/15      03          TO 

06/19      00          TO  

 

T,Td QC  (46780) 
Date    Time    Level  

  GMT    (hPa)  

06/23      12       sfc Td too low  

 

Notes：5/16-6/21 使用 Meisei 系統，6/22-6/26 則使用 Vaisala RS92，RS92 的探空將

可能需要需要日間 dry bias 的校正。多數有問題和錯誤的資料可能是由於在對流附近施

放。 

 

.
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46810（東沙）之初步品質控管評估 

 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料，TO 表示該筆探空的錯誤或有問題資料存在

於整個探空剖面。 

 

Wind QC  (46810)                         Wind QC (46810) continued 

 

Date    Time    Level                         Date    Time     Level 

  GMT    (hPa)                     GMT     (hPa) 

  

05/14      12       750-sfc                         06/04   06 > 700 

05/15      06       880-1000      06/04   18 TO 

05/16      06       ~950       06/05   12 > 300 

05/16      12       100-125       06/06   06 TO 

05/17      18       ~900       06/06   18 250-550 

05/18      12        TO       06/07   00 > 850, < 

150 

05/19      00        830-950      06/07   18 > 500 

05/19      06        ~850       06/11     06 > 900 

05/19      12        < 650       06/11     12     < 150 

05/19      18        TO       06/13     06 300-700 

05/20      06        < 200       06/13   12 > 400 

05/20      12         TO       06/13     18 TO 

05/20      18        < 160       06/14     00      > 170 

05/21      06         > 800, < 250     06/14   06      TO 

05/21      18         < 650       06/14     12      

200-800 

05/22      00         200-500      06/15     00      TO 

05/22      06         TO       06/15     06     ~1000  

05/22      12         TO       06/15     12     ~1000 

05/22      18         > 750, < 130     06/16   00      

700-900 

05/23      12         300-850      06/16     06      > 500 

05/23      18         300-650      06/16     12      > 700 

05/24      18         TO       06/17   00      > 500 

05/25      06          > 950      06/17     12     180-700 
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05/25      12          200-650      06/18     00     300-900 

05/26      18          TO       06/20   00 > 900 

05/27      18          150-500      06/23   00 < 400 

05/28      00          > 700      06/24     00 TO 

05/30      00         300-400      06/24   12 TO 

05/31      00          ~950       06/25   00 TO 

05/31      06          > 700      06/25   12 TO 

05/31      12          > 700 

05/31      18          > 700, 150 

06/02      12          > 700 

06/03      12          250-600 

 

T, Td QC (46810) 
Date    Time    Level  

  GMT    (hPa)  

05/16      18        ~800 SA 

05/17      18        400-800 Td 

05/24      06        sfc, SA 

05/24      12        < 350 

05/26       06       sfc, SA 

05/28      18        TO, Td 

05/30      18        260-280 

06/02      00       ~500 

06/02      12       < 850, Td 

06/03      06       < 450, too warm 

06/03      12        550-650 

06/04      18       < 600, Td 

06/05      12       ~900 SA 

06/21      00       ~930  SA 

06/23      00       ~780 SA  

 

 

Notes：超絕熱層普遍存在於 06Z 的近地面層，這些超絕熱層在某些個案（5/24 與 5/26）

中被標記成有問題的資料，這是因為有較大的強度。
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98223（佬沃, 菲律賓）之初步品質控管評估 

 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料，TO 表示該筆探空的錯誤或有問題資料存在

於整個探空剖面。 

 

Wind QC  (98223) 
 

Date    Time    Level  

  GMT    (hPa)  

05/15      00       sfc    

 

T, Td QC (98223) 
Date    Time    Level  

  GMT    (hPa)  

05/17     00        TO 

06/21     00         < 250 

06/27     12         500-700, Td too dry 

 

Notes：本站使用 GRAW 系統。當新探空儀送達此站時，工作人員才發現不能相容於地

面站的接收軟體，所以，此軟體於 2008 年 5 月底更新，6/1 開始使用。原始資料中釋放

高度為 0m，經過與佬沃探空站的工作人員討論後，真實的高度應為 5m，所以將每一層

的高度加上 5m。 
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99692（北船）之初步品質控管評估 

 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料，TO 表示該筆探空的錯誤或有問題資料存在

於整個探空剖面。 

 

Wind QC (99692) : 沒發現問題。 

 

 

T, Td QC (99692) 
 

Date    Time    Level  

  GMT    (hPa)  

 

05/30     00       Td sfc 

05/31     06        T, Td, sfc 

06/01     00        Td sfc 

06/01     06         Td sfc 

 

Notes：處理此站時是將作業人員額外紀錄之獨立的地面觀測值當成探空的第一筆，但不

幸地，在 6/2 之前並沒有紀錄地面觀測值。另外，此站使用的 Vaisala RS92 探空儀可能

需要日間 dry bias 的校正。
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99744（六龜）之初步品質控管評估 

 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料，TO 表示該筆探空的錯誤或有問題資料存在

於整個探空剖面。 

 

Wind QC： 

 

Date    Time    Level  

  GMT    (hPa)  

 

 06/26     06       ~500  

  

T, Td QC： 

 

Date    Time    Level  

  GMT    (hPa)  

06/20      03       Td near surface  

 

Notes: 此站使用的 Vaisala RS92 探空儀可能需要日間 dry bias 的校正。 

 

 

99759（恆春）之初步品質控管評估 

 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料。 

 

Wind QC：沒發現問題。 

 

T, Td QC：沒發現問題。 

 

Notes：此站使用的 Vaisala RS92 探空儀可能需要日間 dry bias 的校正。 
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99770（台中）之初步品質控管評估 
 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料，TO 表示該筆探空的錯誤或有問題資料存在

於整個探空剖面。 

 

Wind QC                Wind QC (continued) 
 

Date    Time    Level          Date   Time   Level 

  GMT    (hPa)         GMT   (hPa) 

       

05/15      06        near sfc        

05/16      00        ~220     06/13      18        ~600 

05/19      06        ~160     06/14      03        ~800 

05/19      18        ~625     06/14      12        ~650 

05/20      06         ~550     06/14      15        > 700 

05/21      06         ~390     06/15       00       ~925 

05/21      12         ~750     06/15       03       ~900 

05/23      12         ~975     06/15       06       ~975 

05/26      00         ~650     06/15       09       ~975 

05/26   18       ~600                  06/16       03       > 550 

05/28    06        850-950               06/16       06       ~700 

05/29      06       600-900                06/16       09       sfc-750 

05/30    03       ~750                  06/17       03       ~650 

05/30      15         350-500 

05/31      03         ~850 

05/31      06          > 850 

05/31      09         550-650 

05/31      12          > 900 

06/02      18          ~ 650 

06/03      00          350-sfc 

06/03      12         ~440 

06/03      18          ~ 430 

06/05      09          120-250 

06/05      15          > 500 

06/05      21          ~975 

06/06      09          ~950 
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06/06      15          ~700 

06/07      00          ~950 

06/08      00          ~700 

06/08      12          ~200 

06/11      06          850-900 

06/12      00          > 550 

06/12      06          > 450 

 

T, Td QC： 

 

Date    Time    Level  

  GMT    (hPa)  

  

06/01       03      sfc Td too low 

06/01       09       ~960 Td 

06/05       00       ~960 Td 

06/05       06       ~960 Td 

06/05       15        ~950 SA 

06/06       03         sfc Td too low 

06/06       06        ~960 Td 

06/08       12        ~960 Td 

06/13       00         sfc Td too low 

06/17       03        TO, T too warm 

 

 

 

Notes：此站使用的 Vaisala RS92 探空儀可能需要日間 dry bias 的校正。有許多筆雜亂

的風場剖面是因為探空在對流附近施放所導致。
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99810（南船）之初步品質控管評估 
 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料。 

 

 

Wind QC：沒發現問題。 

 

 

T, Td QC： 

 

Date    Time    Level  

  GMT    (hPa)  

 

05/15     06        sfc 

05/19     12        500-600 Td 

05/20     06        500-850 Td 

06/04     18        ~800 Td 

06/13     06         sfc 

 

Notes：許多 06 和 12Z 施放的探空在近地面有較大的超絕熱溫度遞減率，這可能是由於

船體結構的加熱。原始資料中顯示探空釋放高度為 0m，經過進一步的討論後，甲板的高

度應為 3m，因此每層的高度皆直接加上 3m。
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Dropsondes 之初步品質控管評估 
 

當使用下列時間的資料時須特別小心，氣壓層摽是有問題資料大約出現的位置。粗體字表

示為錯誤的資料，其他則代表有問題的資料。 

 

Wind QC： 

 

Date    Time    Level  

  GMT    (hPa) 

 

06/05     0607    < 300  

06/17     0455    ~580 

06/17     0529    ~400, ~200 

 

 

T, Td QC： 

 

Date    Time    Level  

  GMT    (hPa)  

 

05/02     0304     ~625, ~925 

05/02     0337     600-650 

05/20     2251     ~775  

06/03     2330     550-750 

06/04     0528      ~650 

06/04     0611      ~625, SA 

06/04     2328       ~750 

06/04     2332      450-650 

06/04     2347      750-950 

06/25     1043      ~450 

 

Note：05/20 2327Z、05/29 2159Z 及 2211Z、06/04 0603Z 沒有經緯度資訊。在第四次

任務（5/30）之前有明顯的資料遺失問題，在這之後，較新的探空儀大大地改進資料遺失

問題。
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七、尚在進行之工作： 

  q_dif 之結果顯示 Vaisala RS80 探空儀會有顯著的 dry bias，而透過比較探空儀與

GPS 的總可降水量(PW)更可幫助我們更進一步估計 dry bias 的大小。如果探空站周圍 25

公里內沒有 GPS 資料，可使用客觀分析法把資料內差到探空站的地點；海島站（東沙、

馬公和綠島）沒有 GPS-PW，可利用 AMSR-E 衛星所估計出的 PW，衛星一天通過台灣

地區兩次（06 及 18Z），AMSR-E 的資料可到下列網址下載：http://www.remss.com/。 

  在 SoWMEX 期間，Vaisala RS80 的 dry bias 早就被發現了，因此，計劃辦公室於

2008 年 6 月在屏東站（46750）針對 Vaisala RS80 與 RS92 進行一系列的探空比對試驗

計劃（Intercomparison Launches），此資料庫包含 18 個比對探空，而我們可以利用累

積分布函數法（Cumulative Distribution Function matching method，CDF method）來校

正屏東站 RS80 探空儀的 dry bias (Nuret et al.  2008, Ciesielski et al. 2009)，並且應用

到其他 RS80 的站。此外，林博雄教授也請 Vaisala 公司提供新的探空溼度係數來重新處

理 RS80 的資料。這兩種方法應該同時進行，才能觀察哪種方式可以提供更接近

GPS-PW 或 AMSRE-PW 值。另外，在屏東站進行的比對也建議 RS80 也有輕微的

temperature bias 需要校正。在 Meisei 和 GRAW 系統上也應該藉由比較 sonde-PW 與

GPS-PW 來觀察 bias 是否存在，我們也曾在板橋針對 Meisei、GRAW 與 RS92 進行 12

次探空比對，不幸地，僅在 4 月(4 次)和 10 月(8 次)執行此任務，而沒有在季風條件下進

行，若顯著的 bias 存在於 Meisei 和 GRAW 中，那麼，我們就需要在季風條件下進行額

外的比對實驗，以建立一套適合的校正法。 

  有了比對的資料庫後，CDF 法將可讓品質較差之 Vaisala RS80 達到 RS92 的標準，

而 GPS 和衛星之 PW 可用來檢驗此校正法的強弱，如果經過此校正法後仍存在 dry bias，

那麼就需要額外的校正法，例如：許多研究皆指出 Vaisala RS92 需要日間太陽輻射的校

正（Yoneyama et al., 2008 與 Cady-Pereira et al., 2008）。使用這些校正法後，即可建立

一套經過溼度校正後的 Version 2 資料庫。最後，我們計畫建立以 CSU 格式（Colorado 

State University Format）儲存之 5-hPa 探空資料庫並標上 QC 標籤，這就是 Version 3，

此資料庫將更能節省儲存空間且更便於研究用途上的使用。為了建立品質標籤，各種參數

將會經過一系列自動化品質控管檢驗（gross limit, vertical consistency 等），最後將會以

目視法檢查每 5-hPa 來鑑定任何仍然有問題或是錯誤的資料（可使用 CSU 以 TCL 語法

寫成的 xsnd 軟體）。在 Version 3 中，我們並不會更改任何的資料，僅加入品質控管標籤，

如此一來，使用者將可輕易自己決定要使用哪些資料。 

 期中報告預計完成的項目有： 

  (1)探空資料蒐集與整理 

  (2)資料格式整合並使用 ASPEN QC 

  (3)人工檢視及列表 

這些工作均已完成。 
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前言、 

  期中報告後的工作主要是將 QC 後的探空資料進行分析，找出各種不同類型探空儀的

可能偏差（溼度或溫度），並加以校正，期望得到一組更接近真實大氣環境條件的探空資

料庫。 

 

一、探空資料的溼度校正： 

  圖 7（上）為在 SOP 期間探空儀的地面觀測值（qs）與其量測到的第一筆資料（qs+1）

之平均比溼差異（δq），這邊要注意的是所有探空資料的地面觀測值皆應來自於獨立的

測量儀器。Stull (1988)指出在所有天氣條件下，地面層（10-100m AGL）內的δq 都不

應該超過 1 g kg-1，而在西南氣流實驗期間，Meisei、Vaisala RS92（VS92）跟 GRAW

探空儀都能符合此條件，但 Vaisala RS80（VS80）的δq 卻相當大（> 2 g kg-1）。另外，

台南站（46741）於實驗期間曾使用 VS92 跟 Meisei 兩種不同的探空儀，結果顯示 VS92

有較小的δq（0.33 V.S. 0.67），然而，我們分析探空站鄰近的 GPS 站來反演總可降水

量（Total Precipitable Water，TPW）後發現 Meisei（TPW=58.4 mm）比 VS92（TPW=52.1 

mm）來得溼，所以，此結果也表明台南站的 Meisei 探空儀可能存在輕微的 dry bias。圖

7（下）則為在每 5-hPa 下，出現飽和的頻率，結果顯示在 VS92 的探空站，飽和層發生

的頻率約為 5-10%，這與北美季風實驗（North American Monsoon Experiment）觀測到

的結果相似（Ciesielski et al., 2009），對照之下，VS80 在對流活躍的季風環境中，其

飽和層發生頻率卻不到 1%，這也再次證實 VS80 有顯著的 dry bias，此外，Meisei 探空

儀之飽和層出現頻率也偏低。在台南站，兩種不同探空儀的表現也大不相同，VS92 的發

生頻率是 Meisei 的兩倍，此結果表明 Meisei 仍有輕微的 dry bias。 
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圖 7 地面與探空第一筆量測之平均比溼差異（上圖）以及在每 5-hPa 下，出現飽和的頻

率（下圖）。 

 

  圖 7 的分析結果指出 VS80 探空儀有非常顯著的 dry bias，為了能確定 dry bias 的範

圍及大小，我們先計算每個探空儀的 TPW，再與 GPS 或衛星反演得到的 TPW 做比較。

過去研究指出 GPS 與衛星 TPW 反演的準確率為 1-2 mm（Wentz, 1997, Bock et al., 

2007），顯示遙測反演出的可降水量資料適合用於評估 dry bias。圖 8 是台灣探空站及

GPS 站的位置，為了降低誤差，我們僅選擇距離探空站 50 公里內的 GPS 站。在缺乏

GPS 站的海島（東沙、馬公及綠島）則使用 AMSR-E 衛星反演之 TPW（資料可由以下

網址取得：http://www.remss.com/），AMSR-E 通過台灣附近的時間大約在 06Z 和 18Z，

由於微波反演在陸地上會有困難，所以此產品只適用於海洋上。 
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圖 8 台灣探空站及 GPS 站的位置。不同顏色的圓圈代表不同類型的探空儀，而 GPS 站

圓圈內的充填程度則代表該站在 SOP 期間可以被使用的資料百分比。 

 

  圖 9 為 SOP 期間，利用 multiquadric 客觀內差法（Nuss and Titley, 1994）將 AMSR-E

和 GPS 合併而得到之平均 TPW 分布情形，在中台灣北部山區的山區有一 TPW 最小值，

如果 GPS TPW 在南部山區也有資料的話，那麼此最小值將很有可能同樣會延伸到南部

山區；最大值則出現在中國的南部海岸外，另外，在台灣南部與東北部外海有一相對較大

之 TPW 區存在。 
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圖 9 SoWMEX/TiMREX SOP 期間，將 AMSR-E 和 GPS 合併而得到之平均 TPW 分布情

形。填滿的圓圈代表探空站的位置，不同顏色則代表不同類型的探空儀（如同 3 所示）。 

 

  我們可以藉由圖 9 之分析來得到實驗期間任何位置的平均 TPW，接著我們將各站不

同來源的 TPW（探空資料直接計算、圖 9 的 AMSR-E 與 GPS 之合併分析與最接近的 GPS

站）進行比對（圖 10）。因為有許多的觀測發生在 IOP 期間，此期間為較潮溼的時期，

所以若是使用實際探空資料來直接計算 SOP 的平均 TPW 將會引入 moist bias，為了解決

潮溼期間的過多取樣，所以在使用探空資料計算 TPW 時會採用日平均且每一天都給予相

同的權重。從圖 10 的比較可發現 VS80 的 dry bias 很明顯，其範圍從屏東的 6 mm 到綠

島的 11 mm，綠島有較大的 dry bias 有一部分是因為探空站位於較高的高度（252 m），

此高度差異將會對 TPW 引入約 4 mm 的差異。Meisei 站看起來似乎也有微小的 dry bias

（1-3 mm），這與圖 7 的分析結果一致。圖 10 也建議 VS92 的探空站有輕微的 dry bias，

我們懷疑是日間輻射加熱所導致，為了證實此猜測，更進一步的分析是必須的。六龜的

dry bias 是過大的，這是因為最靠近的 GPS 站所在高度都小於 50 m，而六龜的高度是

266 m，如同前面提到的，此高度的差異將會使 TPW 約有 4 mm 的差異。最後，Graw

站看起來似乎沒有溼度的偏差。 
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圖 10 不同方法之 TPW 比較結果（探空資料直接計算、圖 4 的 AMSR-E 與 GPS 之合併

分析與最接近的 GPS 站）。 

 

三、探空比對研究： 

  在 SoWMEX 期間，Vaisala RS80 的 dry bias 早就被發現了，因此，計劃辦公室於

2008 年 6 月在屏東站（46750）針對 Vaisala VS80 與 VS92 進行一系列的探空比對試驗

計劃（Intercomparison Launches），VS92 探空儀在夜間的溼度偏差很小（甚至沒有），

而日間的 dry bias 則很容易被移除（Yoneyama et al., 2008, Cady-Pereira et al., 2008），

所以適合用來校正其他探空儀的溼度場資料。此資料庫包含 18 個比對探空（10 個日間、

8 個夜間；6 個雨天，3 個陰天及 9 個晴天），表 4 即為在不同溫度與溼度區間下可用來

執行 CDF 配對法的資料筆數，雖然我們只有 18 顆比對探空，但在每個溫度區間皆至少

有 1000 筆資料，顯示此方法相當具代表性。接著，我們可以利用累積頻率分布函數法

（Cumulative Distribution Function matching method，CDF method）來校正屏東站

RS80 探空儀的 dry bias（Nuret et al., 2008, Ciesielski et al., 2009），並且應用到其他

RS80 的站。 

  另外，我們在板橋站（Ban-Ciao，46692）也有 12 筆探空比對資料（Meisei、Graw

與 VS92），不幸的是，這些並不是在季風條件下所取得，而是在 4 月（4 筆）與 10 月

（8 筆）。一些初步的分析顯示只有 VS92 在雲中能達到飽和；在較暖且潮溼的環境下，

Meisei 有較小的 dry bias（5%），然而，Meisei 的相度溼度在 300 hPa 以上幾乎是不變
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的，這也會導致高層有 moist bias。與 VS92 相比，Graw 探空儀在溫度較低時有輕微的

moist bias，而在潮溼環境中有輕微的 dry bias。 

 

表 4 SoWMEX/TiMREX 期間，於屏東站進行之 18 顆比對探空資料在不同溫度與溼度區

間下的總資料筆數。 

日間 

 0~5% 

5~10

% 

10~15

% 

15~20

% 

20~25

% 

25~30

% 

30~35

% 

35~40

% 

40~45

% 

45~50

% 

50~55

% 

55~60

% 

60~65

% 

65~70

% 

70~75

% 

75~80

% 

80~85

% 

85~90

% 

90~95

% 

95~10

0%

Total

20~40 

℃ 
0 7 0 17 16 227 68 58 66 67 76 72 55 44 44 56 36 39 29 28 1005

0~20 

℃ 
0 103 0 39 111 432 53 59 66 67 76 72 55 44 44 56 35 39 31 27 1409

-20~0 

℃ 
0 55 42 136 26 510 52 59 67 67 77 72 55 44 44 56 35 39 34 27 1497

-40~-2

0 ℃ 
0 24 63 246 167 786 52 59 67 67 78 71 55 44 46 55 36 40 37 27 2020

-60~-4

0 ℃ 
0 49 92 142 386 473 52 60 67 67 78 70 55 44 49 54 36 41 39 27 1881

-80~-6

0 ℃ 
0 90 99 157 225 210 52 60 67 68 78 69 55 44 52 53 36 42 39 28 1524

夜間 

 0~5% 

5~10

% 

10~15

% 

15~20

% 

20~25

% 

25~30

% 

30~35

% 

35~40

% 

40~45

% 

45~50

% 

50~55

% 

55~60

% 

60~65

% 

65~70

% 

70~75

% 

75~80

% 

80~85

% 

85~90

% 

90~95

% 

95~10

0%

Total

20~40 

℃ 
0 0 0 8 0 0 98 80 70 61 68 81 67 60 56 56 49 30 46 45 875

0~20 

℃ 
0 0 17 103 0 59 85 81 68 63 68 80 67 60 58 54 48 32 48 44 1035

-20~0 

℃ 
0 9 63 138 22 393 84 81 67 65 68 80 67 60 59 54 48 33 48 44 1483

-40~-2

0 ℃ 
0 13 42 47 14 386 83 82 66 65 68 80 67 60 59 53 47 34 48 46 1360

-60~-4

0 ℃ 
0 9 47 144 47 427 82 83 65 66 68 80 67 61 59 53 45 36 48 48 1535

-80~-6

0 ℃ 
0 15 49 120 106 477 81 83 64 66 68 80 66 61 59 52 42 36 48 48 1621
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四、屏東站與其他 VS80 站的溼度校正： 

 

1.一般的處理方法： 

  如圖 7 和圖 10 所示，屏東站的 VS80 探空儀有顯著的 dry bias，所以要用下列幾種

方法來校正這些資料。首先，所有類型的 Vaisala 探空儀需進行日間太陽加熱的校正

（Yoneyama et al., 2008, Cady-Pereira et al., 2008），接著使用在屏東站進行的 18 個

比對個案（VS80 與 VS92），利用 CDF 配對法可建立一組校正表，根據此校正表即可使

VS80 的資料達達 VS92 的水準。 

 

2.累積分布函數配對法（Cumulative Distribution Function matching method，CDF）： 

  CDF 配對法可將不同溼度與溫度下的 VS80 溼度場作修正，CDF 配對法乃是假設兩

種不同探空儀施放地點具有相似的環境，這代表兩者具有接近均勻的大氣條件存在，因

此，才會有類似的統計條件，而此方法的應用將可校正 VS80 的溼度場，使資料品質達到

VS92 的水準。由於先前的研究也顯示溼度的偏差也存在於垂直方向，所以在進行 CDF

配對法時，不同的溫度區間會有不同的溼度校正，本研究選取溫度範圍為+40 ℃至-80 

℃，每 20 ℃為一區間，例如：我們以 30℃來代表 20~40℃、10℃代表 0~20℃，若想得

到溫度為 20℃下的校正量，則利用 30℃與 10℃的校正量經過線性內差而得出。另外，溼

度是從 0 %至 100 %，每 5%為一區間。以白天時的 20℃-40℃區間為例（圖 11），首先，

我們可以計算出兩個不同種類的探空儀在不同的溫度區間內、相同累積頻率下，VS92 與

VS80 的相對溼度差值（圖 11a），而後，可將此差異轉換成在相同相對溼度下，兩者的相

對溼度差異（圖 11b），由圖 11a 可以清楚地看到當 CDF 為 40%時，VS80 的相對溼度為

72%，而 VS92 則為 82%，VS80 與 VS92 的差異偏差為 10%，這代表 VS80 有 10%的

dry bias，而經過轉換後，圖 11b 則是 VS80 與 VS92 在不同相對溼度下的差異偏差量，

顯示在此溫度區間下，相對溼度為 70%會達到最大，VS80 的相對溼度需有 10%的校正。

每個不同的溫度區間都會產生一張類似 11b 的圖，將這些圖合併後便可得到一張 CDF 校

正表（圖 12），此校正表的橫座標為相對溼度，縱座標為溫度，因此，我們可以得到不同

溫度與溼度下的校正量。除此之外，另一件需要特別注意的事是 CDF 校正表必須將日間

與夜間區分開，如圖 12 所示，這是因為白天與夜晚的大氣環境條件非常不同。對於溫度

大於 0℃而言，夜間最大校正值（10%）出現在相對溼度約為 70%處，而日間最大校正值

為 8%，發生在相對溼度為 65%處；對於溫度小於 0℃來說，夜間 bias 校正量大幅增加，

峰值位於溫度為-60℃~-80℃、相對溼度為 40%處，校正量可達到 25%。
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圖 11 上圖為 VS80 與 VS92 在溫度區間 20~40℃下，相對溼度的累積分布函數。下圖為

經過 CDF 配對法後的相對溼度 bias 校正量。 

 

 

圖 12 利用 CDF 配對法（VS80 與 VS92）在所有溫度區間下的 bias 校正表。左圖為夜

間，右圖為日間，點線代表冰的飽和點。
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3.日間太陽加熱校正： 

  Cady-Pereira et al. (2008) 透過比較探空的 TPW 與衛星微波反演的 TPW，針對不

同類型的 Vaisala 探空儀發展出一套日間溼度校正法。Vaisala 的 dry bias 主要來自於溼

度感應器受到太陽加熱地影響，Vaisala RS80-H 的溼度感應器上有保護蓋以降低日間降

雨和輻射的影響，然而，較新的探空儀（VS90 與 VS92）已移除此保護蓋，所以日間 dry 

bias 會比 VS80 系列來的大。由圖 12 中也可得到 VS80 在白天時，在-20~-40℃範圍內都

比 VS92 來得潮溼（圖 12 右在-20~-40℃的負校正量），這就代表 VS92 有很大的日間輻

射加熱偏差，這與 Cady-Pereira et al. (2008)得到的結果一致，所以，我們將繼續進行此

校正法。 

  對 VS92 探空儀而言，日間輻射加熱校正係數為： 

 





 


SZA
SF

cos

2.0
exp093.00.1  

SF 為一比例係數（Scale Factor）； SZA 則代表太陽天頂角，為測站經緯度、時間及年

份的函數。圖 13 為屏東站在 2008 年 6 月 1 日的 SF 在不同時間的分布情形，我們可以

清楚看到只有在 0530 LST 到 1830LST 之間施放的探空才會受到太陽加熱的影響，且在

1130 至 1300LST 之間施放的探空需經過 8%的修正。實際上，日間校正是將露點溫度（Td）

轉換成混合比（r），而後把每一層的混合比（r）乘上此係數以得到新的混合比，最後，

再用新的混合比計算出新的露點溫度。另外，Vomel et al. (2007)與 Yoneyama et al. (2008)

在最近的研究中，比較 VS92 和 Chill Mirror 溼度計之高精度溼度探空後發現 VS92 的 dry 

bias 會隨高度增加，這也是需要考慮的問題。 

 

圖 13 2008 年 6 月 1 日於屏東站之比例係數（Scale Factor）對混合比的校正程度，為測

站經緯度、當地時間及年份的函數。X 代表一天 8 次的探空施放時間。 

 

4.校正法的應用： 

  所有屏東站所蒐集到的 VS80 探空資料先經過 CDF 校正表，使 VS80 的溼度場達到

VS92 的標準，然後，對所有白天的探空進行日間輻射校正，但在進行這些校正時，也要
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遵循以下的限制，那就是新的露點溫度不能超過溫度，這也使得當溫度大於 0℃，相對溼

度不能超過 100%、當溫度小於 0℃，相對溼度可達到 130%。 

 

5.屏東站校正的驗證： 

  屏東站的探空資料經過 CDF 與日間太陽輻射加熱校正後，在 SOP 期間，平均 TPW

從 48.2 mm 提升至 53.9 mm（約增加 11%）。最靠近的 GPS 站（ZEND）位於屏東站東

方 37 公里處且非常靠近海岸，在 SOP 期間也蒐集到非常完整的紀錄，平均 TPW 為 54.8 

mm，這比校正過的探空值還高 0.9 mm，而 GPS 站有較高的 TPW 可能是因為較接近海

岸。3 小時 GPS 和校正後探空資料之 TPW 的相關係數則為 0.88。 

  接著，我們挑出同時有 GPS 及探空資料的時間點，來分析 TPW 的日夜循環（圖 14

上），在非加強觀測期時，屏東站的釋放時間為 2，8，11，14，20 LST。結果顯示未經

修正的探空資料與 GPS 的差異在每個不同的施放時間介於 5 mm 至 10 mm 之間，而校

正後的探空資料在每個時間點非常接近 GPS 的估計值，兩者的差異在 2 mm 以下。較高

的平均 TPW 出現在 5，17 和 23 LST，這是因為這些時間只有在加強觀測期（IOP）才有

施放探空，這段時間內的對流較旺盛且較潮溼（圖 15）。 

 
圖 14 上圖為總可降水量的日夜循環，GPS-PW 以黑色星號表示，未經校正的探空則是

綠色星號，經過校正後的探空以藍色星號代表僅做過CDF校正、紅色星號則為CDF

與日間太陽輻射校正。下圖為總可降水量差異（GPS-PW – 校正後探空 PW）的

日夜循環，星號表示平均值，垂直線為標準差，底層的數字表示用來計算平均的資

料筆數。 
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圖 15 平均相對溼度之時間序列，垂直線與陰影區代表加強觀測期（IOPs），一天有 8 次

探空的施放。 

 

  下表為屏東站的溼度校正對不同對流參數的影響，經溼度校正後的資料看起來能有效

地移除 dry bias，在未校正前，較低的對流可用位能（CAPE）和較高的對流抑制能（CIN）

表示對流不容易被激發，而在校正後，各種對流參數看起來更合理， 

參 數 未校正 校正後 

可降水量（PW） 48.2 mm 53.9 mm 

對流可用位能(CAPE) 169 J Kg-1 782 J Kg-1 

對流抑制能（CIN） -165 J Kg-1 -84 J Kg-1 

舉升凝結面（LCL） 900 hPa 924 hPa 

平衡面（EL） 215 hPa 164 hPa 

 

6.將校正法應用在其他 VS80 站： 

  從屏東站得到的 CDF 校正表（圖 12）與日間太陽輻射加熱校正將被應用在其他 VS80

站，結果如圖 16 所示，初步的分析結果顯示僅有在花蓮站可得到不錯的結果。 

 

圖 16 不同方法之 TPW 比較結果（探空資料直接計算、圖 4 的 AMSR-E 與 GPS 之合併

分析與最接近的 GPS 站）。紅色長條為 VS80 與 VS92 的溼度校正作用。 
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  除了上述兩種方式外，我們亦提供所有 VS80 原始探空資料給 Vaisala，所以，我們

又得到另外一組經 Vaisala 原廠新係數校正後的資料，此資料庫的品質已相當不錯，僅需

進行 RS-80 的日間太陽輻射加熱校正。可惜的是，Vaisala 沒有辦法重新建造花蓮站之探

空，然而，圖 16 已清楚地告訴我們若將前述兩種校正法應用在花蓮站便能得到相當不錯

的結果。 

 

五、VS92 探空儀的溼度校正：  

  所有日間 VS92 探空儀將進行日間太陽加熱校正。 

 

六、Meisei 探空儀之探空站的溼度校正：  

  某些校正看起來似乎是需要的，但是必須有更多的分析來證實校正的範圍及大小。 

 

七、Graw 探空儀的溼度校正：  

  目前看起來似乎不用對溼度進行校正，若仍有輕微的 bias 存在，那麼，我們就需要

額外的比對實驗，以建立一套適合的校正法。 

 

八、目前正持續進行之工作： 

  截至目前為止，我們已成功建立一套經過溼度校正後的 Version 2 資料庫，接下去仍

會建立另一組 5-hPa 探空資料庫，此 5-hPa 探空資料庫將會標記上 QC 標籤，這就是

Version 3，我們預期此資料庫將更能節省儲存空間且更便於研究用途上的使用。為了建

立品質控管（QC）標籤，各種參數將會經過一系列自動化品質控管檢驗（gross limit, 

vertical consistency 等），最後還會以目視法檢查每 5-hPa 的資料，以鑑定任何仍然有問

題或是錯誤的資料（可使用 CSU 以 TCL 語法寫成的 xsnd 軟體）。在 Version 3 中，我

們並不會更改任何的資料，僅加入品質控管標籤，如此一來，使用者將可輕易自己決定

要使用哪些資料。 

 期末報告預計完成的項目有： 

  (1)利用 GPS 或衛星反演出的可降水量（PW）來檢驗探空資料的溼度偏差。 

  (2)分析校驗比對資料，確認不同類型探空儀是否需要校正。 

  (3)探空資料校正方法研究與分析 

這些工作均已完成。 
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5.計畫變更說明： 

 按原計畫進行中無變更。 

 

6.落後原因：  

 按原計畫進行中無落後。
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不同種類探空儀的特性： 

  在 SoWMEX/TiMREX 實驗開始前（4 月 15~16 日，共 4 顆）於板橋站進行一系列的

比對研究，參與的探空儀類型有 Meisei、Vaisala RS-92 以及 Graw，三種不同類型的探

空儀綁在同一顆氣球上一起升空。圖 zzz 即為初步分析結果，從相對溼度來看，當探空儀

經過雲時，只有 RS-92 可以達到飽和，Graw 與 Meisei 從 800 到 950 hPa 約比 RS-92

乾 3~5%，而 RS-92 在 300 hPa 以上明顯偏乾，Vaisala RS-92 在高層偏乾乃是受到太陽

輻射加熱所導致之 dry bias。此外，與 RS-92 相比，Graw 與 Meisei 較暖，特別是 Meisei，

雖然我們從此結果可以得知不同探空儀的溫度亦不相同，但卻無足夠證據證明哪一種探空

儀的溫度才是真值，因此，現階段我們僅針對溼度的 bias 來作校正。 

 

 

 

 

 

 
圖 17a 2008 年 4 月 15 日 00Z 於板橋實施之比對研究（VS92、Graw 與 Meisei）。左側

為相對溼度、右側為溫度差（T - Tmean）；紅色實線為 Meisei，藍色實線為 Vaisala 

RS92，黑色實線為 Graw，綠色點虛線則為標準差。 
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圖 17b 2008 年 4 月 16 日 00Z 於板橋實施之比對研究（VS92、Graw 與 Meisei）。左側

為相對溼度、右側為溫度差（T - Tmean）；紅色實線為 Meisei，藍色實線為 Vaisala 

RS92，黑色實線為 Graw，綠色點虛線則為標準差。 
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Introduction 

Aspen (Atmospheric Sounding Processing Environment) is used for analysis and quality 
control (QC) of sounding data. It has the following capabilities: 

• Automatically apply quality control procedures to the sounding data 

• Present data in tabular and graphical forms 
• Automatically determine levels and code them in WMO message formats 

• Transmit the WMO messages to other systems 
• Save the raw and derived data products in various formats 

Since Aspen can process data provided in the AVAPS “D” file, NCAR GLASS, NCAR 
MCASS and NCAR CLASS formats, it is able to analyze both dropsonde and upsonde 
soundings. 
Aspen is designed to operate as automatically as possible, while allowing the user to have 
some control over the QC methods. For instance, as soon as the user selects a sounding 
file for processing, the data is brought into Aspen and automatically analyzed. In most 
cases this first pass will be the only one required. If the processing needs to be modified, 
the user can change the QC parameters and reprocess the data as many times as 
necessary. 
An extensive series of QC algorithms are applied to the data. These algorithms typically 
have one or two parameters that may be adjusted by the user if the default values are not 
suitable for a particular sounding. The user can save the modified options, so that when a 
new sounding is opened, the initial analysis will use the customized QC parameters. 
Aspen can have up to six sounding files open at the same time. This makes it convenient 
to compare soundings.  
Aspen is designed so that its operation requires minimal user intervention. However, 
there are a few concepts that are very helpful in understanding the behavior of the 
program. 

 
Aspen maintains two separate data sets: the raw data and the QC data. 
At the start of processing, the QC data is an exact copy of the raw 
data. The algorithms are then successively applied to the QC data. As 
the processing proceeds, data points that fail each test are removed 
from QC data set. At the end of this process, a final smoothing is 
applied to the remaining QC data. It is important to understand that 
nearly all of the QC steps simply remove unreliable points from the 
raw data set. The dynamic adjustments and the final smoothing are 
the only steps where the observed data values are actually modified. 

 

The QC 
process 
mainly 
removes 
suspect 
data points 
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A sounding is simply a time series of observations, and so almost all 
of the QC operations are based on the time of each data point. The 
QC parameters are specified in relation to time, and the tabular data 
listings are ordered by time. 

 
The complete processing routine is applied as soon as a sounding is 
selected for analysis, and whenever the user chooses to recompute the 
analysis. The sequence is as follows: 

1) Apply the QC algorithms, discarding bad points and 
applying corrections 

2) Compute the levels, by analyzing the QC results. 
3) Code the WMO message, using the levels as input. 

 
Throughout this manual, notes in italics provide additional information and suggestions 
which, while not essential to operation, will help you use Aspen more effectively. 

Time is the 
independent 
variable 

The 
processing 
follows a 
fixed 
sequence 
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Overview of Operation 

To run Aspen, double click on the Aspen icon , or choose Aspen 
from the start menu. An initial start screen will appear. If the file 

selector does not appear immediately, choose Open under the File menu:  

 

 
 
You will now see the file selector: 
 

 

 
 
The file selector is used to choose the sounding file to be processed. You can move to 
other directories using the up directory button or the directory chooser. The file filter 
controls the file types that are displayed in the chooser. 

If you do not see your data files in the directory where they are supposed 
to be, it is probably because the file filter is set incorrectly. Change the file 
filter to “All files (*.*)” in order to display all files in the directory. 

 

Directory chooser 

 

Up directory 

File filter 

1 Run 

File menu 
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Select the file containing the sounding that you want to analyze. 
Click once on the file and then press “Open”, or double-click the file 
name.  

Aspen will show a warning message if you select a file that is in a format 
which it can’t process. 

Processing of the sounding begins as soon as the file is opened. The progress of the 
analysis is displayed in the status box in the lower left hand corner of the main screen, but 
until the processing is complete, the screen will remain blank. 

When the sounding analysis has completed, the initial screen will be filled with a tab-
based display, in which each tab represents a different view of the data. The tabs are 
arranged from left to right (see figure below) in the general order of the data processing, 
i.e. from raw data, through the QC and levels computation, to the coded message. Read 
the Tab Displays section for further description. 

 
 

Verify the sounding by examining all of the tab selections. Read  the 
Post-Processing Adjustment section for important guidelines on 
doing this. After examining the sounding, the user may decide that 
one or more of the processing parameters should be adjusted.  

 

The most commonly altered processing parameters can be 
changed on the Main tab. When they have been set to the 
desired values, press the Recompute button on the Main Tab 

to reanalyze the sounding using the new parameters. The processing status will again be 
displayed in the lower left status box. When completed, the displays in each tab will be 
updated with the new results. 

Be sure to press the Recompute button after changing the processing 
parameters; otherwise, the new parameters will not be applied to the 
sounding. 

To analyze another sounding, open another data file 
using the FileOpen menu. Many soundings can be 
open at one time. Use the Window menu to choose 
which sounding is displayed. 

2 

3 

4 

5 

Open 

Next Sounding 
 

Recompute 
(if necessary) 

Verify 
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Post-Processing Adjustment 

Once a sounding has been processed by Aspen, the results must be examined carefully. 
Frequently some parameters will need to be adjusted to compensate for characteristics of 
the data.  

End of data 
In a well-behaved sounding, the end of the raw data set will occur at the end of the 
sounding. For a dropsonde landing in water, this is the usual case. For a dropsonde hitting 
the earth, or with upsondes, the raw data can contain observations that should not be 
included in the processed sounding. The user must then manually specify the end of the 
drop by setting the end of drop time on the Main tab. It is critical that the end of drop be 
correctly set for dropsonde soundings 
The Raw data table and the XY graph are useful for determining the end time. Scroll to 
the bottom of the raw data to view the values of individual data points. On the XY graph, 
enable the raw data trace, and use the mouse to zoom in the area of the sounding end. 
Data point markers and grids can be enabled with buttons above the graph. 

The QC tabular display will only show data points that are within the end 
of data time period. 

Dropsonde                                                                                                                                      
heights and the surface 
For dropsonde soundings, the height calculations are the trickiest part of the Aspen 
analysis. If the drop terminated cleanly at a known altitude, upward integration of the 
heights is straightforward. Upward integration is impossible, however, if the dropsonde 
termination altitude is unknown. This can occur if the drop did not make it all of the way 
to the surface, or if it the termination point on land had an unknown altitude (which is 
almost always the case).  

In the latter situations, the sounding heights can be computed by downward integration 
from the launch altitude. Note that this suitable only if the launch altitude is known with 
accuracy. Usually the launch altitude is provided by the aircraft data system, and it is 
critical to determine the accuracy of this altitude. If altitude is provided by a radar 
altimeter over the ocean, it is probably acceptable. If it is provided by a pressure-based 
altimeter, at some time or distance since the altimeter setting was applied, the aircraft-
provided altitude is probably not acceptable. 
The Main tab has several items that relate to the height calculations. In the box labeled 
“Height Overrides” there are check buttons that have the following effects: 

• Hit Surface – Check this check box if the dropsonde hit the surface. The heights 
will be integrated up from the surface altitude. 
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• Unknown Surface Altitude – Check this box if the surface altitude is unknown, 
such as when a dropsonde has terminated on land. The heights will be integrated 
down from the launch altitude. 

• Set Heights Unknown – Check this box if you feel the heights are not sufficiently 
accurate, no matter which way they are calculated. The heights will not be 
calculated or used in latter processing. 

At the lower right of the Main tab is a box displaying the results of the upward and 
downward height integrations. This is shown for diagnostic purposes. If downward 
integration leads to a launch altitude close to the surface altitude and, likewise, the 
upward integration is close to the launch altitude, then there is confidence in the launch 
altitude. If there are significant discrepancies, the launch altitude is probably incorrect. 
Additionally, differences in the diagnostics can signify a large systematic error in the 
variables used in the height integration, i.e. pressure, temperature or humidity. 
If the surface altitude can be determined for a launch which terminated on land, this value 
can be entered into the surface altitude box, so that the upward integration can be 
computed. 

The final item affecting the height calculation is the Launch Altitude entry in the Launch 
Parameters box in the upper left corner of the Main tab. If another source of the launch 
altitude is available, it may be entered here in order to override the aircraft supplied 
value. The Clear button can be used to remove the override.   

It should be pointed out that the heights are mainly relevant to the coding of the WMO 
messages, where they are used to report the altitudes of standard pressure surfaces. Even 
if the heights are unusable, the WMO message will still contain a very accurate report of 
the sounding based on pressure. The upshot is to set heights to missing when in doubt, 
rather than report erroneous values.  

Launch parameters 
The launch parameters are the surface or aircraft flight level observation made at the time 
of launch. They become either the bottom or top point in the sounding, depending on the 
sounding direction. The QC procedures assume that these launch observations are 
accurate, so they will not be changed. If the launch observations do need to be modified, 
the Launch Parameters box in the upper left corner of the Main Tab has entries that allow 
the user to override them. Enter the new values into the boxes. Use the Clear button to 
revert to the original values. Be sure to hit “Recompute”. 
 

Setting the QC parameters 
The QC parameters, which control the operation of the various QC algorithms, can be 
modified by the user. However, only experienced users who understand the effects of the 
parameters should do this. See the Quality Control Procedures section for a complete 
description.  
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The QC parameters are organized in named sets, with one of them designated as the 
currently active set. The parameters in the active set are the ones used for succeeding 
analyses by Aspen. The active set name is displayed on the right side of the status bar at 
the bottom of the Aspen application window. It is visible for every Aspen tab: 
 

 
The initial installation of Aspen provides a configuration set named “dropsonde”, and 
designates it as active. These parameters are generally useful for dropsonde soundings in 
a tropical environment. If analyzing dropsonde soundings in different environments, as 
well as upsonde soundings, you will almost always need to create a new configuration set 
and adjust its QC parameters appropriately. 

See the Configuration section for directions on setting the active set, maintaining 
configuration sets. 

 
The user should be in the habit of always checking the status bar to verify 
that the correct configuration set is designated as active. 
 
To change the choice of active configuration set, close all sounding files 
within Aspen. The file menu will now have a “Configuration…” entry that 
allows access to the configuration editor. 
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Tab Displays 

Sounding Identifier 
Each tab displays an identifier that describes the sounding. The details are extracted from 
various fields within the raw data file. For graphical displays, this information is printed 
as text on the graph. For other tabs, a yellow bar at the top of the tab contains the 
identification (see figure below). 

Main Tab 

 
 

The Main tab is used to specify certain characteristics of the sounding, and to override the 
launch point observations. Entering a value into the appropriate box specifies the 
override. To remove the override, press the associated Clear button. 
Directions for using the height-related controls is discussed in the Post-Processing 
Adjustments section. 
Be sure to press “RECOMPUTE” after changing items on the Main tab. 
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Raw and QC Tabs 
 

 

 

These two tabs each provide a table of data values. The data is listed in time order. The 
scrollbar on the right side is used to scroll up and down within the table. Notice that the 
pressure of the current scroll position is displayed as the scrollbar is moved. 
The Print and Print Preview commands on the File menu are available for the Raw and 
QC tabs. The preview can be used to determine on which pages a particular range of data 
points falls. The Print command is used to print either the whole table or selected pages. 
The complete table for a sounding will range from 8 pages (drops from 700 mb) to 
upwards of 50 pages (upsondes to <100 mb). 

The Save command allows the data to be saved in the NCAR CLASS or netCDF formats. 
The CLASS format produces an ASCII text file that can easily be imported into 
spreadsheets. 

The launch observations are shown as the first line in the Raw and QC 
data displays. They will not be modified by the QC processing, but 
override values can be specified by the user. 
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XY Graph Tab 
 

 
 

This tab provides numerous options for graphical display of the data. The buttons above 
the graph select which data products and parameters are displayed. The buttons also 
select the choice of vertical axis. The main options on the XY Graph tab are as follows: 

 
Time – Pres – Alt.  These buttons select the parameter displayed along the vertical 
axis. When the tab is first selected, time is chosen as the vertical axis, with only the 
QC data plotted. This leads to the “cleanest” display, since time uniformly increases 
in both the raw and QC data. When the raw data is displayed using the pressure or 
altitude axis, the display may be confusing due to noise in the raw pressure reading.  

 
Zoom - UnZm.  To magnify (zoom) an area of the plot, left-click and drag to draw a 
rectangle around the area of interest. Release the left mouse button to zoom into the 
defined area. The UnZm button restores the graph to the full area display. 
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If the plot is zoomed into a particular area, and then the plot data type is 
changed, or a different vertical axis is selected, the plot area may go 
blank. This is because the zoom area is now in the wrong region for the 
new plot type. Hit the UnZm button to restore the plot to its full region. 
 

Max.  The Max button can be pressed in order to expand the plot to the full screen of 
the monitor. Press the Esc key to bring the monitor back to the normal configuration. 
 

QC – Raw. The QC and Raw buttons select the dataset(s) to be displayed in the 
graph. The two datasets can be displayed simultaneously. Conversely, if neither 
button is selected, no data will be displayed. 
  

Levels.  Pressing the Levels buttons causes the computed levels to be overlaid on the 
graph. Moving the mouse pointer over a level symbol will cause the level type to be 
displayed. Standard levels are displayed as triangles, and other levels are displayed as 
circles. 

Different levels types contain different sets of parameters. For instance, 
the standard levels report temperature, moisture, winds and altitude. On 
the T-RH plot, the standard levels will appear for any vertical axis choice. 
If the axis is set to altitude, however, the significant levels will not be 
shown here, since they are not reporting altitude. Also, if a particular field 
is missing from a level, it will not be overlaid on a trace. For instance, if a 
standard level does not have a temperature data value, it will not appear 
on the temperature trace. 

 
Grids – MarkPts. Grid overlays may be selected from the drop-down list above the 
graph. Marking of the data points can be toggled on and off using the MarkPts push 
button. 

  
The four buttons on the far right select the parameters to be plotted along the horizontal 
axis: 

T – RH.  Selects temperature and relative humidity. 

Speed - Dir.  Selects wind speed and direction. 
Sats – Dz.   Selects number of satellites and ascent speed. 

Pres - Alt.   Selects pressure and altitude.  
The Save button on the far right is used to save the graphic image as a PNG or JPEG file. 
PNG provides better compression and much higher quality graphics presentation for the 
line drawings of Aspen, and is the preferred file format. The pixel dimensions of the 
saved graphic file can be specified in the configuration options. 
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Other plotting options are available by holding down the right mouse button over the plot.  

 

Skew-T Tab 

 
 

A standard skew-T log-P plot is accessed in the Skew-T tab. Zooming, maximizing, 
printing and saving of the plot are available in the same manner as for the XY Graph. The 
right mouse button brings up the same menu of plot options as well. 

Meteorologists  are accustomed to seeing a particular aspect ratio on skew-T plots and 
thus a consistent shape of the various isopleths. To maintain the correct aspect ratio when 
zooming, choose a zoom box whose lower left and upper right corners share a common 
temperature, i.e. they share a common diagonal. An example of a correct zooming 
rectangle is superimposed on the figure above. 
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Levels Tab 

 
 

The Levels tab displays the computed levels, which have been derived from the QC data 
set. The surface and standard levels are highlighted in blue. These are the levels that are 
coded in parts A and C of the WMO message. The levels data can be previewed and 
printed from the File menu. 

The levels listing may be sorted by any of the variables by clicking on the desired column 
heading. Clicking a second time in the same heading reverses the order of the sorting. It 
is typical to sort either by time or pressure, both of which will give similar results. 
In certain cases the Aspen operator may wish to prevent particular levels from being 
coded in the WMO message. Clicking on a level in the Levels Tab will mark a level so 
that it is not coded. Excluded levels are marked with a red background. Click again on the 
level to toggle its status back for normal coding.  Clicking on the temperature, RH, speed, 
direction or altitude fields will select that individual field and prevent it from being coded 
in the WMO message. Clicking on any other field (the columns to the left of these) will 
disable the whole level.  

Not all variables are recorded for each level. This is because each level 
type is used to report only specific variable in the coded message. If a 
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variable is not reported for a given level type, it is not calculated for that 
level. 

 
 

 

WMO Tab 

 
 

The WMO tab displays the WMO message, which has been coded from the levels infor-
mation. It can be previewed and printed from the File menu, and also saved as a text file 
using the Save and Print buttons.  
The WMO message can be emailed from within Aspen by pressing the Email button on 
this tab. The email recipient is specified by the “TempEmailAddress” configuration 
parameter. When the Email button is pressed, the default Windows mail client (e.g. 
Outlook or Outlook Express) is started, and the user is presented with an email editing 
window.  If the message is being mailed to an automatic processing system, such as the 
NWS email GTS ingest gateway, then the mail client should be configured to send in 
plain text format, and to no wrap the text lines. Group or alias entries can also be made in 
the client address book (e.g. “GTS”) to serve as the message recipient address. 
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The format for the WMO message is very exacting, and there may be times when Aspen 
does not get the coding quite right. The buttons at the top left of the WMO tab allow the 
user to modify the WMO message if necessary. Use the mouse to select the code group to 
be edited, and press the appropriate editing button.  

Some code groups, such as the abbreviated header, the 61616 group, and 
the 62626 group contain more than the nominal 5 characters. To select 
these groups for editing, you must click on the left end of the code group. 

There are a number of administrative entries in the WMO message that are not derived 
from the levels data. These are items such as the abbreviated header, and information in 
the 61616 and 62626 groups. This information is managed on the Comm tab. When a 
field is changed on the Comm tab, the WMO message is adjusted accordingly. 

If the sounding analysis is recomputed (from the Main tab), a new WMO 
message will be coded, and any edits made previously will be lost. 

 

 

Comm Tab 
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The Comm tab is used to enter the administrative information that is coded in the WMO 
message. It also has controls for transmitting the WMO message via an attached interface 
on the USAFR WC130 aircraft. The field names should be self-explanatory. 
Press the “Send TEMPDROP message” button to transmit the WMO message. A 
message box will pop up to indicate that the transmission is in progress. 

Most of the data entry fields on the Comm tab are saved as soon as they 
are entered, and used as the defaults for the next sounding that is 
processed. Be sure to verify that the fields are correct before saving or 
transmitting the message.  
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Menu Commands 

The menu commands will be familiar to anyone who has previously used Windows-based 
programs. Only the Tools Menu contains commands unique to Aspen. 

File Menu 
The File menu contains command choices that are generally applicable to all tabs within 
Aspen. There are cases when a command cannot be used with a particular tab. For 
instance, when the Main tab is selected, the File Save command is not enabled, since 
there is no data product associated with this tab. The following commands are found 
under the File menu: 
Open…  Open a sounding file and begin the processing. 

Close  Close the sounding. 
Configuration. Open the configuration editor (available only when no soundings are open. 

Save…  Save data products associated with the tab. 
Print…  Print the tab. The output print format will depend on the tab type. 

Print Preview Preview the print output. 
Print Setup… Configure the printer. 

At the bottom of the File menu is a list of the most recently analyzed files. Sometimes it 
is convenient to go here to reopen a sounding that you have recently examined. 

See the “Configuration” section for an explanation of the configuration management 
procedures. 

Tools Menu 
The Tools menu provides access to commands associated with the QC parameters, when 
a sounding is open. See the “Configuration” section for their description. 

View Menu 
The display of toolbar and status lines is controlled in the View menu. 

Window Menu 
The Window menu contains a listing of all of the soundings currently being analyzed by 
Aspen. Clicking on the file name will bring that sounding to the front of the display.  

Toolbar 
The Toolbar provides buttons that can be clicked instead of selecting some of the entries 
found on the drop-down menus. As with the File menu, the buttons that are enabled 
depend upon which tab is currently selected. 
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Quality Control Procedures 

One of the main purposes of Aspen is to apply quality control algorithms to a sounding. 
These algorithms attempt to systematically detect data points that are likely to be 
incorrect, and remove them from the QC data set. 

The processing begins with a copy of the original (raw) observations. In most cases, all 
parameters are considered separately. The main exception to this is the handling of the 
wind observations. In this case, the wind speed and direction are separated into u and v 
components, and the QC tests are individually applied. However, if one of the two 
components fails a test, then both components as well as the speed and direction are 
removed from the QC data.  

There are other QC tests that depend upon the relationship between two variables; in 
some algorithms, the processing of a given parameter requires input from another 
parameter. For instance, the GPS-measured velocity is used as a discriminator for the 
horizontal wind observations. In another case, the dynamic adjustment procedure requires 
the time constant of the sensor making the measurement. This time constant is a function 
of density and ventilation rate, which are obtained from the pressure and vertical velocity. 

The Algorithms 
The following table lists the QC processing steps, in the order that Aspen applies them. 
Also listed are the sounding direction and variables to which each step is applied. 
Following the table is a more detailed description of each step. 

 
Table 1. QC Processing Steps 

Sounding 
Direction 

Variable Procedure 

Dn Up P T RH Wind 

Note 

1.  Launch parameter 
overrides 

      a 

2.  Copy raw data set to 
QC data set 

       

3.  End of drop override        

4.  Ambient equilibration        

5.  Apply fixed offsets        
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Sounding 
Direction 

Variable Procedure 

Dn Up P T RH Wind 

Note 

6.  Limit Check        

7.  Satellite Check       b 

8.  Buddy Check        

9.  Outlier Check        

10.  Filter Check        

11.  Pressure Smoothing        

12.  Monotonic Pressure 
Check 

       

13.  Temperature Dynamic 
Adjustment 

       

14.  RH Lower Limiting        

15.  Final Smoothing        

16.  RH Lower Limiting        

17.  Pressure Adjustment        

18.  Compute Vertical 
Velocity 

       

19.  Vertical Velocity 
Check 

      b 

20.  Create Surface 
Observation 

       

21.  Winds Dynamic 
Adjustment 

       

22.  Compute Altitude        

23.  Compute Position        
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Sounding 
Direction 

Variable Procedure 

Dn Up P T RH Wind 

Note 

Notes:  a: Launch parameter override for the winds will be available in a future version 
b: GPS based winds only 
c: Dependent upon sonde type 

 

A description of each processing step follows. If the step can be adjusted via a 
configuration parameter, the title for the configuration item is listed, as it appears on the 
Aspen configuration-editing dialog. See the Configuration section for details on 
managing Aspen configurations. 
1. Launch parameter overrides  Dn   Up   P   T   RH 
The user-specified launch parameter overrides, if any, are substituted for the ones given 
in the data file.  

2. Copy raw data set to QC data set  Dn  Up P T RH Wind 
The QC data set is initialized with a copy of the original observation. If the option is 
chosen to discard frames with CRC errors, these frames are not copied to the QC data set, 
except for the very last frame in the original observation (applies only to AVAPS 
dropsonde soundings). 
3. End of drop override   Dn  Up P T RH Wind 
If the user has specified an end of drop time, all data beyond this time is ignored. 
4. Ambient equilibration   Dn    P T RH Wind  
A dropsonde undergoes an extreme change in environment when exiting the aircraft. The 
pressure, temperature and RH sensors require a significant time period to get close to the 
ambient conditions. This equilibration time is calculated to be 7 times the time constant 
of the sensor, and data within this period is discarded.  

The temperature time constant is dependent on the ventilation rate (which is the fall rate), 
and the air density. Right at the dropsonde launch, the pressure sensor is undergoing 
extreme changes, and cannot be used to determine the dropsonde fall rate. For this 
reason, a theoretical fall rate is calculated, which is based on the force balance between 
the parachute drag and the mass of the sonde. This fall rate has been shown to be 
reasonably accurate. The aircraft measured temperature and pressure, or the first 
observed values in the sounding, are used to calculate the density, and the temperature 
time constant at launch is computed using these parameters.  

The ambient equilibration region for pressure is set equal to the temperature region, so 
that pressure and temperature have the same data coverage at the top of the sounding. 

An empirically determined formulation for the RH time constant is used.  
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5. Apply fixed offsets   Dn  Up P T RH  
Fixed offsets can be added to the measurement. Configuration Item: Offset to Add 
6. Limit Check    Dn  Up P T RH Wind 
Absolute bounds checks are used to discard measurements falling outside of hard limits. 
The limits are set at: 
Table 2. Limit Check Bounds 

Parameter Minimum Maximum 

P 1 mb 1200 mb 

T -100 °C 50 °C 

RH 0 % 100 % 

Wind Speed 0 m/s 150 m/s 

Wind Direction 0 360 

 

7. Satellite Check    Dn  Up    Wind 
GPS-derived winds are not reliable if an insufficient number of satellites are used in their 
computation. If the number of satellites falls below a minimum, the associated wind 
observations are discarded. Configuration item: Number of Satellites 
8. Buddy Check    Dn  Up P T RH Wind 
This test uses the data points on either side of an observation to check for consistency, 
and is useful for detecting and removing wild points. Since the neighboring points may 
be separated from the observation by varying time deltas, the buddy check thresholds are 
specified in terms of change per unit time. A point is discarded if it shows a change 
greater than the limit for one neighbor, and a change greater than the limit, but of the 
opposite sign, for the other neighbor. Configuration Item: Buddy Check Slope 
9. Outlier Check    Dn  Up P T RH Wind 
A least-squares linear fit to the data series is calculated. Data points that are greater than a 
specified multiple of the standard deviation from the linear fit are removed from the data 
set. Configuration Item: Outlier Check 
10. Filter Check    Dn  Up P T RH Wind 
A copy of the data series is low pass filtered at a given wavelength. Data points are 
removed if they differ from the filtered series by greater than a specified deviation. 
Configuration Items: QC Filter Wavelength, QC Filter Deviation 
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11. Pressure Smoothing   Dn  Up P  
The smoothing is applied to the pressure data. The pressure needs to be smoothed before 
the pressure monotonic check. If the final smoothing wavelength is set to 0, this is not 
applied. A small amount of final smoothing should almost always be applied to pressure, 
so that reverse trends in pressure caused by noise will not cause a data point to be 
discarded. Configuration Item: Final Smoothing 
12. Monotonic Pressure Check  Dn  Up P 
The pressure trace must change monotonically in order for pressure-based searching to be 
performed. The pressure time series is scanned; when a point is found which follows an 
incorrect trend (i.e. decreasing for a dropsonde, increasing otherwise), it is removed from 
the series. 
13. Temperature Dynamic Adjustment Dn    T  
The temperature is adjusted for the time lag related to the sensor time constant. The time 
constant is a function of the sonde ascent rate and the density. An empirically determined 
relation for the sensor time constant, as a function of pressure and ascent rate, is used.  
The series is first smoothed using the temperature dynamic correction smoothing 
wavelength. This smoothed series is used to compute a time tendency for each data point. 
Each observation is then adjusted by adding to it the product of the time constant and 
tendency. Configuration items: Dynamic Correction On-Off and Dynamic Correction 
Wavelength 

14. RH Lower Limiting   Dn  Up   RH  
RH values less than 0.2% are set to 0.2%. 

15. Final Smoothing    Dn  Up  T RH Wind 
The series are smoothed using the final smoothing wavelength. If the final smoothing 
wavelength is set to 0, this is not applied. Configuration Item: Final Smoothing 
16. RH Lower Limiting   Dn  Up   RH  
RH values less than 0.2% are set to 0.2%. 
17. Pressure Adjustment   Dn   P  
If a surface pressure is specified on the main tab, it is proportionally applied to the 
pressure profile as a function of time. Thus the bottom pressure value becomes the 
specified pressure, and the launch pressure is unchanged, with a proportional adjustment 
applied between these points. 

18. Compute Vertical Velocity  Dn  Up P  
The pressure series is first smoothed using the final pressure-smoothing wavelength. The 
time tendency of the pressure is then computed at each data point. The time-differentiated 
hydrostatic equation is then used to compute the vertical velocity.  
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19. Vertical Velocity Check   Dn  Up    Wind 
The GPS-measured fall velocity is a good discriminator for the quality of the GPS-
derived horizontal wind. If the difference between the hydrostatically determined fall 
velocity and the GPS-measured velocity is greater than the specified limit, the horizontal 
wind point is discarded. Configuration item: Vertical Velocity Threshold 
20. Create Surface Observation  Dn   P T RH  
In order to achieve as accurate a surface pressure reading as possible, a procedure is 
applied which attempts to account for the distance the dropsonde fell to the surface after 
the last data point was reported. Empirical estimates of this distance are used to 
extrapolate the last surface pressure measurement to the surface. The last temperature and 
RH are simply duplicated for the surface measurement, since the distance is generally on 
the order of 5 meters. These fabricated measurements of pressure, temperature and RH 
are appended to the data series.  
21. Winds Dynamic Adjustment  Dn  Up    Wind 
Each wind component is adjusted with the formula: unew = uobs - (du/dt)*(dz/dt)/g. The 
wind component series is first smoothed, using the winds dynamic correction smoothing 
wavelength for the component. This smoothed series is used to compute a time tendency 
for each data point. The observation is then adjusted according to the formula, using the 
previously calculated vertical velocity for dz/dt. Configuration items: Dynamic 
Adjustment On-Off and Dynamic Correction Wavelength 
22. Compute Altitude    Dn  Up  
The hydrostatic equation is integrated from the surface upwards. For dropsondes, the 
same computation may be made from the launch altitude downward. See the Post-
Processing Adjustment section for a description of dropsonde height computations. 

The downward height integration requires both a starting altitude and a starting pressure. 
If the pressure at launch time for a dropsonde is not available (a common situation on 
many aircraft), the first raw pressure point from the dropsonde is used as the launch 
pressure, but only for the purpose of height computation. This unwarranted assumption 
can lead to significant height errors if the raw sonde pressure data is late or inaccurate. 
23. Compute Position    Dn  Up  
The horizontal winds are used to integrate the sonde location from the initial launch 
position. If a time gap of greater than maximum position integration interval (a 
configuration parameter) occurs in the wind measurements, the integration terminates.  
The position integration requires an initial position to start the integration. Similarly, an 
initial wind speed and direction at the launch point are used in the integration. If these are 
not available, Aspen will use the first Q/C wind speed and direction as the launch point 
value. This unjustified assumption thus assumes a constant wind profile at launch, in the 
absence of a wind measurement at the launch point. Configuration Item: Position 
Interpolation 
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Guidelines for Adjusting QC Parameters 
The supplied default values for the Aspen Q/C parameters in general produce excellent 
results. However, there may be times when a group of soundings have peculiar error 
characteristics, and the Q/C paramaters need to be modified in order to produce better 
discrimnation against outliers. Some tips for adjusting the configuration parameters are 
given here. The user should carefully read and understand the descriptions of the Q/C 
algorithms given in the preceeding section; this will provide the best guidance on 
modifying the Q/C parameters to match the error characteristics of the sounding data. 

• Toggle the display of raw data off and on in order to see which data points are 
being rejected by the algorithms. Toggle the “mark points” option, and use the 
zoom and pan capabilities freely to investigate the effectiveness of the procedures. 
Stay zoomed in on a region when modifying configuration parameters, and use 
the “!” (recompute) button to reprocess the sounding, so that the new results are 
displayed immediately in the zoomed region. 

• If the sounding system does not report the number of GPS satelittes used in the 
winds calculation, set the GPS satellite threshold to 0, so that winds are not 
discarded due to a lack of satellites. 

• The most frequently adjusted parameters are the the QC Filter Wavelength and 
the QC Filter Deviation, which are used in the filter check and are applied 
together. In this algorithm, a smoothed curve is calculated from the data series. If 
the filter wavelength is small, the curve will closely follow the data; if large the 
curve will be a very smooth representation of the data. The deviation is the 
amount that a data point is allowed to deviate from the smoothed curve. If the 
difference between the curve and the raw data point is larger than the deviation, 
the data point is discarded. The interplay between the amount of smoothing and 
the allowed deviation allow for wide latitiude in tuning the filter check algorithm. 

• The dynamic adjustments for temperature and wind speed can significantly 
increase the variance of the data series. If the Q/C results appear noiser than the 
raw data, it will be due to the dynamic adjustments. Use of the dynamic 
adjustments is the perogative of the user, and can be deactivated in the 
configuration. Note that the tendency of the series, used in the adjustment, is 
calculated from a smoothed version of the data. The dynamic correction 
smoothing wavelength is used for the smoothing value during the dynamic 
adjustment procedure. If a very small smoothing wavelength is specified, the 
variance increase in the Q/C data can become significant. 
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Configuration 

Aspen is very flexible and can produce a large variety of output products. It will analyze 
data from a number of different sounding systems. In order to tailor it for differing 
applications, Aspen provides a configuration system. This same system is used to 
configure Aspen, BatchAspen and AspenQC, and the configuration information is shared 
between each of these programs. 

Configuration Items: At the heart of the configuration system is the configuration item, 
which matches a keyword with a current value, and a default value. The keyword 
identifies a particular characteristic to be used during the next Aspen analysis; e.g. the 
smoothing wavelength to be applied the pressure field, or the mass of the dropsonde. 

Configuration sets: A family of configuration items is collected in a configuration set. 
Configuration sets are assigned names, and a named set is chosen as the currently active 
one, to be used the next time that Aspen is run. In this way, users can create configuration 
sets that are tailored to a particular instrument, environment, or field program, and switch 
between them as needed. 
The Active Set: At any time, one of the named configuration sets is designated as the 
active set. This means that any further processing with Aspen or BatchAspen will use the 
configuration items from the active set. It is critical that the user verify that the 
correct set has been designated as active when processing soundings. 
A user interface is provided within Aspen and BatchAspen for manipulating the Aspen 
configuration. This is divided into two activities. The first is the management of the 
configuration sets: creating, deleting and activating a set. The second is modification of 
the configuration items within a selected set. 
Note that within Aspen, the management of the configuration sets can only be initiated 
from the File menu, when no soundings are currently open. Configuration items for any 
named set may be modified at this time also. However, configuration items for the 
currently active set may also be modified when soundings are open within Aspen. 
aspen.xml: The configuration information is stored in XML1 format, in a file named 
aspen.xml. A “Document Type Definition file”, aspen.dtd, accompanies aspen.xml, and 
must be located in the same directory. See the Appendix A: Configuration Parameters, 
for a description of aspen.xml. 
The location of these files depends upon the version of Windows, as well as the 
ASPENCONFIG environment variable. When Aspen first runs, it checks to see if 
ASPENCONFIG is set. If it is, Aspen then checks for the existence of the configuration 

                                                
1 XML: Extensible Markup Language; this is a widely used standard for defining structured data, and is 
used extensively in Web applications. 
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files in that directory. If the files are not found, Aspen offers to copy default 
configuration files to that directory. 
If ASPENCONFIG is not set, Aspen will assume directories for the configuration files, 
according to the following: 

• For Windows 98 systems: The directory where Aspen is installed  
• For Windows NT/2000/XP systems: C:\Documents and Settings\<user 

name>\Application Data\Aspen\. This scheme allows individual users to maintain 
private versions of the configuration files. 

Configuration Set Management 
Management of the configuration sets is available through the File->Configure… menu 
within Aspen and BatchAspen. Choosing this item will cause a configuration set 
management dialog to open, from which configuration sets may be activated, deleted, 
created  and edited: 
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The selection drop down box at the top of the dialog is used to select the named 
configuration set that all other operations will reference. The selected set can be 
activated, deleted, or edited using other buttons in the dialog. To create a new 
configuration set, select an existing set to be used a source set, enter a name in the box, 
and hit the Create button. 
When all configuration editing actions are finished, hit the Ok button to save them, or the 
Cancel button to discard the changes. 
The actual configuration items for the selected configuration set can be edited by hitting 
the Edit button. This will bring up a dialog from which the quality control parameters and 
other options can be modified. See the “Changing the QC Parameters” section (below) 
for details on modifying the configuration items from this dialog. 
Hitting the Restore Defaults button will restore the entire set of configuration items for 
the selected set, restoring them to their default values.  
The Sample Configuration Set: There is a special configuration set, named sample, 
provided with Aspen. This set cannot be activated, deleted or edited. It is available as a 
default set that can be used as the source when creating a new configuration set. 

Remember that within Aspen, the configuration editor is only available 
(from the File->Cofigure… menu) when no soundings are open. When 
soundings are open in Aspen, the options for the currently active 
configuration set can be edited from the Tools->Options menu. 

Changing the QC Parameters 
In order to configure Aspen to match your particular requirements, the configuration 
items (i.e. parameters) within a configuration set must be properly specified. This can be 
initiated from either the configuration management menu (File->Configure…->Edit 
Options) when no files are open, or from the options menu (Tools->Options…). A tabbed 
property sheet will open, containing two tabs. The “Quality Control Parameters” tab is 
used to configure quality control parameters: 
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The quality control parameters are used to adjust the various quality control algorithms, 
and are described in the “Quality Control Procedures” section. 

Other Options 
The “Other Options” tab provides further options for the processing of sounding data: 
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QC Processing.  In normal usage, this feature should always be enabled. If it is 
turned off, Aspen will only display the raw sounding data. This may be useful if you 
want a quick look at a large data set without waiting for processing. 
Levels – WMO message.  These two features should always be enabled if WMO 
messages are the ultimate data product (e.g. weather reconnaissance). For all other 
soundings, these features may be turned off. 
Levels Thresholds. These five parameters set the thresholds used in the 
determination of the GDL levels for the designated measurement. They should be 
modified with caution, since this would result in a deviation from the specifications of 
the FMH-3. 
Tropopause Level Detection: Lapse Rate Smoothing Wavelength. This is the 
wavelength of the smoother that will be applied to the temperature data before the 
automatic determination of tropopause levels is made. A tropopause is identified by 
the derivative of the temperature lapse rate, and so a high variance in temperature can 
lead to the creation of unrealistic tropopause levels. 

WMO Message Type.   Choose the type of TEMP message to be generated for an 
upsonde sounding. 
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Block Station Number and Call Sign.   These are identifiers that are required either 
for the TEMP, TEMPSHIP, or TEMPMOBILE messages. 
Upsonde Abbreviated Header. The WMO abbreviated header for upsonde WMO 
messages. (Note that dropsonde abbreviated headers are specified on the Comm tab). 

Upsonde ICAO Code. ICAO code for upsonde abbreviated headers. (Note that 
dropsonde ICAO codes are specified on the Comm tab). 

Email address for TEMP. Address to receive an emailed WMO message. 
Append NNNN Terminator. If checked, append NNNN to the WMO message when 
it is saved or emailed. Some communications systems, such as the GTS, require this 
terminator. 

Disable Abbreviated Header.  If checked, the abbreviated header will not be 
generated for the WMO message. This is useful in the common situation where 
another system generates the abbreviated header. 
Dropsonde Mass and Parachute Area.   The dropsonde mass and parachute area are 
required in order to estimate the initial fall speed of the dropsonde, after launch from 
the aircraft. The values differ only from the defaults in special cases where a custom 
parachute or modified sonde are deployed. 
Dropsonde Hit Surface. This box is checked if the dropsonde was believed to have 
hit the surface. This causes the sounding altitudes to be integrated from the surface 
altitude upwards; otherwise they will be integrated from the flight level altitude (if 
available) downward. If checked it also allows the computation of an extrapolated 
surface data point. 

Surface Altitude Unknown. Check this box if the dropsonde was believed to have 
hit the surface, but the surface altitude is unknown, as in a dropsonde landing on the 
earth. It causes the height integration to be performed from flight level down. 
Discard frames with CRC errors. If this box is checked, data frames that are 
marked as having a CRC error are discarded. This only applies to AVAPS dropsonde 
soundings. 

RH Channel. The AVAPS/Dropsonde based systems use a radiosonde that carries 
dual relative humidity sensors. The firmware in the sonde chooses the humidity value 
from one of them, and the selected channel is reported in the main RH field of the 
“D” file. The original values for both sensors are reported in additional columns in 
the file. The user can elect to use the sonde chosen value (AVAPS selected), or either 
of the original sensor values (RH1 or RH2). 

Set Heights Missing. Check this box to cause the height computations to be skipped, 
in cases where the operator does not trust the data to provide for accurate height 
integration. 
Open File Chooser on Startup.   If this box is checked, a File Chooser dialog will 
open as soon as aspen is started. Otherwise, the File menu can be accessed in order to 
select a file to process. 
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Position Interpolation Interval.   Set the maximum time interval over which the 
winds can be interpolated for the position integration calculation. If the gap in winds 
is greater than this interval, the winds will not be interpolated and the position 
integration will stop. 

Plot dimensions, pixels. Specify the X and Y dimensions, in pixels, for graphics 
output files. 

Default plot file. Choose either PNG or JPG as the default choice for the output 
graphics file format. The user can also choose the file type at save time. PNG is the 
recommended format. 
Generate Q/C diagnostics file. Select this to cause a file with Q/C diagnostic 
information to be created. The file name will begin with ‘AspenDebug’ and have a .txt 
extension. It will be created either in the directory where the Aspen program is 
installed, or the directory where the first data file is located. Be sure to disable this 
option when finished, otherwise diagnostic files will be created every time Aspen is 
run. 

Saving Changes and Restoring Defaults 
When the user closes a sounding in which the QC parameters have been changed, a 
dialog box asks if these parameters should be saved as the processing defaults. All 
soundings opened after this time will be processed using these options. The Tools menu 
provides a command, ToolsRestore Defaults, which can be used to restore the options 
to initial system defaults. Thus the customized parameters will revert to the initial 
installation defaults.  

The user may also revert the QC parameters to the initial installation defaults before 
opening any soundings. This is done via the File Configure…Restore Defaults button 
(available only when no soundings have been opened). 
 

When in doubt about the proper values of the QC parameters, restore the 
defaults. 
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Corrupted Configurations 
As mentioned above, the configuration information is stored in the aspen.xml file. If the 
configuration file becomes corrupted, Aspen will not be able to run, and the file will need 
to be repaired or restored. 

The file “AspenOriginal.xml” is provided as a copy of the orginally distributed 
configuration file, and is located in the Aspen installation directory (typically 
“C:/Program Files/ NCAR/Aspen”. In the worst case, this file can simply be copied over 
aspen.xml (note that the file name case is significant). This will restore Aspen to the 
default configuration parameters, but all changes or additions that have been made to the 
configuration will be lost. 

If the aspen.xml file is only slightly corrupted, it may be possible to correct the error with 
a text editor. A simple way to locate a syntax error is to open aspen.xml in Internet 
Explorer, which provides structured viewing of XML files. Internet Explorer will indicate 
lines that do not parse correctly, and then a standard text editor may be used to fix minor 
problems. 
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BatchAspen 

BatchAspen is a separate application that is used to apply the Aspen Q/C procedures to a 
collection of sounding files. The user selects the data products to be created. The program 
then iterates over the list of files, placing the results in a specified destination directory. 

BatchAspen shares an exact copy of the Q/C processing algorithms that are used by 
Aspen, so that identical results for both programs can be guaranteed. 

Starting BatchAspen and Selecting Files 

Start the application by clicking on the BatchAspen icon . A single screen will be 
presented. The screen is roughly divided into left and right sections, with control buttons 
in between. The left side is used to select the files to be processed. The right side 
specifies the output file destination and the processing list: 
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On the left side, there are two independent directory browsers, either of which can be 
used to navigate into directories containing input files. The files in the selected directory 
are shown in the file selector in the lower left. The display of file types can be restricted 
using the “File Filter” in the center edit box. 

Individual files can be selected, using the standard Explorer left-click, shift-left-click, and 
ctrl-left-click mouse selection commands. Once the desired files are chosen, press the 
“Add->” button to add them to the processing list on the right side of the screen. Pressing 
“Add All->” will cause all of the displayed files to be added to the processing list. 

Selected files can also be dragged from the file selector and dropped into the processing 
list. 

 Files from multiple directories can be collected in a single processing list. 
However, all output files will be created in a single directory. 

Files may be removed from the processing list by selecting them in the processing list, 
and pressing the “<-Remove” button, or press “<-Remove All” in order to empty the list 
completely. 
To select the output directory, hit the “Browse” button above the processing list. A folder 
browser will pop up; use it to select the folder for the output files.  
 

 
 

Create a new folder by pressing the “new folder”  button. 
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Q/C Processing 
The desired output products are chosen using the toggles: 

  
An output file of each selected type will be created for each input file.  

To begin the processing, hit the  button. BatchAspen will start processing 
each file, starting at the beginning of the list. A status indicator will appear next to each 
file, with a yellow star denoting the file currently being processed. A check mark 
indicates that the file was successfully processed; an unhappy face denotes a file that 
could not be processed.  

 
During the processing of each file, the status box at the top of BatchAspen provides a 
running display of the Q/C processing steps. 
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When processing is underway, the “Process” button changes to . To stop the 
processing before the end of the list has been reached, press Abort. BatchAspen will stop 
when the processing of the current file has completed2. 

Q/C Parameters 
BatchAspen uses the same configuration scheme as Aspen, which is documented fully in 
the “Configuration” section. As with Aspen, activating the File->Configure… menu item 
will display the configuration management interface.  

The configuration set that is designated as active is used by both Aspen 
and BatchAspen. 

 

 

                                                
2 This may take up to several minutes on a slow machine. 
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AspenQC 

AspenQC is a version of Aspen that performs the Q/C and message coding functions, but 
does not provide a graphical user interface. Therefore, it can be run from shell scripts or 
the command line, to process a sounding data file in a standalone mode. The same Q/C 
and coding algorithms used in Aspen are incorporated into AspenQC. 
A Windows executable file, AspenQC.exe, is provided in the Aspen Windows 
distribution. AspenQC can be compiled and run under Linux. Contact NCAR in order to 
obtain the source code for Linux.  

AspenQC uses the same XML configuration file as Aspen, located in the ASPENHOME 
directory. 

Switches 
Command line switches control the processing and output products from AspenQC: 
usage: AspenQC [-i|--input <sounding file>] 

               [-e|--csv [<output csv file>]] 

               [-c|--class [<output class file>]] 

               [-w|--wmo [<output wmo file>]] 

               [-n|--netcdf <output netcdf file>] 

               [-v|--verbose] 

               [-s|config <config set name>] 

               [-a|--csvattributes] [-h|--help] 

• i – the name of the input data file. AspenQC will automatically determine the file 
type, and as with Aspen, will make assumptions about the type of souding, 
dependent on the file format. AVAPS, CLASS, GLASS, MCASS and CSV 
format files can be processed. If this parameter is missing, the data are read from 
standard input. 

• e – Generate a CSV format output file (“-e” is meant to indicate Excel, since CSV 
files are the best method for transferring data between AspenQC and Excel). 

• c – Generate a CLASS format output file. 
 

• n – Generate a netCDF format output file. 
 

• w – Generate a WMO message. 
 

• v – Print (verbose) status messages as the processing proceeds. 
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• s – Specify a config set name to override the one selected by the <active> tag in 
the XML configuration file. 

• e – If a CSV file is being created, print the configuration attributes at the 
beginning of the file. 
 Note that these will not be interpreted or used when a CSV file is used as input to 
AspenQC. 

• h  – Print out the usage statement. 
 

The output format specifiers (-e, -c, -w and –n) can take an optional file name, to which 
the data will be written. If not provided, the data will be written to the standard output. 

An example of an AspenQC usage would be: 
AspenQC –i classData.dat –a –e classData.csv 
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Input File Types 

Aspen can process sounding data that is provided in the following file formats: 

• NCAR AVAPS GPS Dropsonde “D” files 
• NCAR GLASS Upsonde files  

• NCAR GAUS Upsonde files  
• NCAR CLASS Upsonde files 

• NCAR MCASS Upsonde files 
• “Comma Separated Values” (CSV) (MS Excel compatible)3 

Warning: Aspen automatically detects the format of the file that it opens, 
and assumes that the sounding contained is from the associated 
instrument. This can lead to ambiguities, if Aspen is used to process a file 
that it has written. For instance, if dropsonde data are saved by Aspen in 
“CLASS” format, and then this file is used as input to Aspen, the program 
will assume that the data are from an upsonde sounding, rather than a 
dropsonde. This can lead to erroneous results within Aspen, since the 
characteristics of the sounding system affect the processing procedures. 

 
Output files can be produced for data products in the following formats: 
Table 3. Output File Types 

Data Product File Output Formats 

Raw data NetCDF 
CSV 
NCAR CLASS format ASCII text 
NCAR EOL format ASCII text 

QC data NetCDF 
CSV 
NCAR CLASS format ASCII text 
NCAR EOL format ASCII text 

Graphics JPG 
PNG 

                                                
3 See Comma Separated Values (CSV) on page 50 for a more general description of Aspen compatible 
CSV files. 
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Data Product File Output Formats 

(or use Alt-PrtSc for clipboard capture) 

Levels None 

WMO message ASCII text 
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Appendix A: Configuration Parameters 

The Aspen configuration is stored in XML format. There are two files: aspen.xml and 
aspen.dtd. aspen.xml contains the actual configuration values, while aspen.dtd defines the 
syntax of the aspen.xml file. 

Explanation of the structure of XML files is beyond the scope of this manual. However, 
given an existing XML file, it is not difficult to discern the layout of the information4. 
XML elements are delineated by start and end tags, and are nested to create a hierarchical 
data structure. aspen.xml observes the following structure: 
<aspenConfig> 

<active>dropsonde</active> 
<set name="sample"> 

  <option name="SetHtsMissing" type="bool"> 
   <current>false</current> 
   <default>false</default> 

</option> 
. 
. 
. 
<option name="WindSmoothWL" type="numeric"> 

   <current>10.000000</current> 
   <default>10.0</default> 
  </option> 

<option immediate="true" name="IcaoIndex" type="numeric"> 
 

   <current>1.000000</current> 
 

   <default>1</default> 
 

</option> 

 </set> 
<set name="dropsonde"> 
. 
. 
. 

 </set> 
</aspenConfig> 
 

Thus, the Aspen configuration contains one entry (<active>), designating which named 
configuration set is active, followed by one or more named configuration sets (<set>). 

                                                
4 This is particularly easy if the the file is examined with an XML capable browser, such as Internet 
Explorer. 
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Each configuration set contains a list of configuration options (<option>), with the 
current and default values for each option. Each option has a designated type: 

• bool – boolean, with a value of either true or false. 
• numeric – A floating point numeric value. 

• string – A text string.  
An option may also be marked with “immediate=true” to effect an immediate save of the 
option when it is changed. It is useful for some options to be saved immediately after 
they are changed, before closing the sounding in Aspen, so that when the next sounding 
is analyzed, it will immediately use the new version of the option. For instance, if the 
dropsonde operator on the Hurricane Hunter aircraft opens a sounding, and then changes 
the ICAO value for the TEMP message, it is likely that all soundings opened during the 
same run of Aspen should use this value for the ICAO string. An immediate save allows 
the configuration to be updated, without having to close that sounding. 
The following table gives a description of the configuration options. 

The case of the configuration item name is critical. It must be matched 
exactly as shown. 

Element name Type Description 

SetHtsMissing bool Corresponds to the “Set heights 
missing” checkbox on the main tab, 
which causes height computations to 
be skipped. 

DropsondeHitSfc bool Corresponds to the “Dropsonde Hit 
Surface” checkbox on the main tab, 
indicationg that the dropsonde 
sounding terminated with hitting the 
surface. 

SfcAltUnknown bool Corresponds to the “Surface Altitude 
Unknown” checkbox on the main tab, 
which when set causes the upward 
height computation to be skipped. 

DiscardBadCrcData bool Set true if frames with CRC errors 
are to be discarded. (AVAPS 
dropsondes only). 

ReportObservedPos bool If true, the sonde position reported 
in the input file will be used in 
place of the winds integrated 
position. Lat and Lon from the input 
file will go directly into output 
products and the tabular displays. 
This can be utilized to take 
advantage of sondes which report GPS 
positions directly. The default is 
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Element name Type Description 

false. 

WindSmoothWL numeric Final smoothing wavelength. Set this 
to 0 to disable final smoothing. 

WindQCWL numeric Filter check smoothing wavelength. 

WindDynCor bool Enable dynamic correction. 

WindDynCorWL numeric The wavelength used when smoothing 
the wind data prior to calculating 
the derivative used in the dynamic 
correction. 

WindBuddySlope numeric Buddy check slope limit. 

WindQCDev numeric Filter check deviation limit. 

WindsDisableQCFilter bool Do not perform the QC filter for the 
winds. 

WindOutlier numeric Outlier check number of standard dev. 
limit. 

WindsDisableOutlierCheck bool Do not perform the outlier check for 
winds. 

WindSats numeric Minimum number of GPS satellites 
required in wind solution. 

WindVVdelta numeric Vertical velocity check limit. 

WindEquilTime Numeric For dropsondes, winds falling within 
this time period from the launch will 
be discarded. 

PresSmoothWL numeric Final smoothing wavelength. Set this 
to 0 to disable final smoothing. 

PresQCWL numeric Filter check smoothing wavelength. 

PresBuddySlope numeric Buddy check slope limit. 

PresQCDev numeric Filter check deviation limit. 

PresOutlier numeric Outlier check number of standard dev. 
limit. 

PresOffset numeric Offset correction. 

TdryQCWL numeric Filter check smoothing wavelength. 
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Element name Type Description 

TdryDynCor bool Enable dynamic correction. 

TdryDynCorWL numeric The wavelength used when smoothing 
the temperature data prior to 
calculating the derivative used in 
the dynamic correction. 

TdryQCDev numeric Filter check deviation limit. 

TdryOutlier numeric Outlier check number of standard dev. 
limit. 

TdryOffset numeric Offset correction. 

TdryBuddySlope numeric Buddy check slope limit. 

TdrySmoothWL numeric Final smoothing wavelength. Set this 
to 0 to disable final smoothing. 

RHSmoothWL numeric Final smoothing wavelength. Set this 
to 0 to disable final smoothing. 

RHQCWL numeric Filter check smoothing wavelength. 

RHBuddySlope numeric Buddy check slope limit. 

RHQCDev numeric Filter check deviation limit. 

RHOutlier numeric Outlier check number of standard dev. 
limit. 

RHOffset numeric Offset correction. 

TdryLevelDelta numeric Threshold value for GDL determination 
on temperature.  

RHLevelDelta numeric Threshold value for GDL determination 
on RH.  

WspdLevelDelta numeric Threshold value for GDL determination 
on wind speed. 

Wspd850LevelDelta numeric Threshold value for GDL determination 
on windspeed, below 850 mb. Applies 
only to dropsondes. 

WdirLevelDelta numeric Threshold value for GDL determination 
on wind direction. 

TropSmoothWL numeric The wavelength used for smoothing of 
the temperature time series before 
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Element name Type Description 

calculation of tropopause levels. 

DoQC bool True to perform quality control 
processing. 

DoLevels bool True to calculate levels. 

DoWMO bool True to create the coded message. 

AutoFile bool True to enable of file chooser when 
aspen starts. 

ChuteArea numeric Dropsonde parachute cross section 
area , cm2. 

 

DropSondeMass numeric Dropsonde mass, grams. 

PosInterpSpan numeric Maximum time span, in seconds, over 
which the position integration will 
be interpolated. 

CallSign string Immediate, call sign for TEMPSHIP and 
TEMPMOBIL messages. 

BSN string Immediate, Block Station Number for 
TEMP messages. 

TempMsgType numeric Temp message type (0=TEMP, 
1=TEMPSHIP, 2=TEMPMOBIL) 

TempApendNNNN Bool Set true if an NNNN should be 
appended to the TEMP message when it 
is saved in a file. This terminator 
is required by some telecommunication 
gateways. 

RHchoice numeric AVAPS RH channel selection(0=AVAPS 
selected, 1=RH1, 2=RH2) 

ExcludeAbrHdr bool True if the abreviated header should 
be excluded from the TEMPDROP 
message. 

PlotPixelsX numeric Default plot X dimension in pixels. 

PlotPixelsY numeric Default plot Y dimension in pixels. 

PlotFileFormat numeric Default graphics file output format 
(0=PNG, 1=JPG) 
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Element name Type Description 

ACtype numeric Immediate, Dropsonde aircraft type 
(0=C130H, 1=C130J). Use only for the 
automated file transfer method for 
Huricane Hunters. 

BaudRateIndex numeric Immediate, serial port baud rate 
selector for Hurricane Hunter C130H 
aircraft. (0=300, 1=1200, 2=2400, 
3=4800, 4=9600, 5=19200, 6=38400) 

CommPortIndex numeric Immediate, serial com port selector 
for Hurricane Hunter C130H aircraft. 
(0=com1, 1=com2, … 7=com8) 

ACagency string Immediate, agency designator in the 
TEMPDROP 61616 group. 

MissionStorm string Immediate, storm designator in the 
TEMPDROP 61616 group. 

MissionId string Immediate, mission id designator in 
the TEMPDROP 61616 group. 

IcaoIndex numeric Immediate, index of ICAO designator 
(0=user defined, 1=KNHC, 2=KBIX, 
3=KISX, 4=KHIK, 5=KTRR. For TEMPDROP 
messages. 

AbrHdrOvr string Immediate, User defined overide for 
the abreviated header. For TEMPDROP 
messages. 

AtcfId String Immediate, the ATCF cyclone or storm 
system identifier. 

OptIcao numeric Immediate, user defined optional ICAO 
identifier. For TEMPDROP messages. 

UpsondeAbrHdr string Immediate, abbreviated header code 
(e.g. UUNA15) for upsonde messages.  

UpsondeICAO string Immediate, ICAO code (e.g. KWBC) for 
upsonde messages. 

TempEmailAddress String Immediate, email address that TEMP 
messages should be sent to. 

DataDir string Directory where input data files are 
located. 

WmoSaveDir string Directory to save WMO messages in. 
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Element name Type Description 

QCSaveDir string Directory to save QC data in. 

RawSaveDir string Directory to save raw data in. 

XYPlotSaveDir string Directory to save XY plot graphics 
in. 

SkewTPlotSaveDir string Directory to save Skew-t plot 
graphics in. 

BatchSaveDir string For BatchAspen use, defines the 
diretory that output files will be 
written to. 

BatchSaveRawCLS bool For BatchAspen use, set true to save 
the raw data in a CLASS format file. 

BatchSaveQCCLS bool For BatchAspen use, set true to save 
the Q/C data in a CLASS format file. 

BatchSaveRawCDF bool For BatchAspen use, set true to save 
the raw data in a netCDF format file. 

BatchSaveQCCDF bool For BatchAspen use, set true to save 
the Q/C data in a netCDF format file. 

BatchSaveRawCSV bool For BatchAspen use, set true to save 
the raw data in a CSV format file. 

BatchSaveQCCSV bool For BatchAspen use, set true to save 
the Q/C data in a CSV format file. 

BatchSaveWMO bool For BatchAspen use, set true to save 
the WMO message in a text file. 

FixedSrcEnabled bool If true, the source data and save 
destination directories will 
specified by FixedSrcDir 

FixedSrcDir string The directory to use as a data source 
and a save destination, if 
FixedSrcEnabled is set to true. 

QcDiagFile Bool If true, create a text file 
containing diagnostic information 
from the Q/C process. Usually not of 
much use to the typical user. The 
file will be written to either the 
directory where Aspen is installed, 
or the directory that the first data 
file read is located. The file name 
begins with AspenDebug-, is followed 
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Element name Type Description 

by a time stamp and then a .txt 
extension. 

Table 4. Configuration Parameters 
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Appendix B: File formats 

An overview of the output file formats is given here. The file structures are 
sraightforward, and examination of the files will provide most of the documentation on 
their formats.  

Note that the file formats are not complete; i.e one format will contain information that 
another format does not support. Thus, the CSV and netCDF formats can document the 
configuration parameters used in the processing, whereas the CLASS format does not 
support inclusion of this information. 

CLASS Format 
The CLASS file starts with a 15 line header section, followed by a variable number of 
data lines. The data lines are arranged in fixed width columns. A mandatory set of 21 data 
parameters is reported, even though a number of these (specifically the “quality” values) 
are always marked with a missing value indicator. 
The data is reported in the sequence of decreasing pressure, i.e. from the surface upward, 
regardless of the direction of the sounding. 

EOL Format 
The EOL file starts with a 15 line header section, followed by a variable number of data 
lines. The data lines are arranged in fixed width columns. A fixed set of 17 data 
parameters is reported 

The data is reported in the sequence of decreasing pressure, i.e. from the surface upward, 
regardless of the direction of the sounding. 

NetCDF 
Section “Appendix D: netCDF Attributes” contains the attributes listing from an ncdump 
of an Aspen generated netCDF file. Note that for legacy compatibilty reasons, a number 
of unecessary variables are included in the netCDF file. The global attributes contain a 
record of the Q/C processing options. 

Comma Separated Values (CSV) 
The “Comma Separated Value” file format is used for data interchange between Aspen 
and other software. It is a free form structure, with one data record per line, and the fields 
in a record separated by commas. A CSV file can be read directly into Microsoft Excel, 
and the data will be correctly organized in the spreadsheet. 

For input to Aspen, certain conventions must be followed within the CSV file. 
Each line begins with an identifier, followed by one or more fields. The order of the lines 
is generally not important, within the following guidelines: 
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• The first line must be:  
FileFormat,CSV 

• After the first line, the launch time must be provided on lines as follows: 
 
Year,2001 
Month,08 
Day,01 
Hour,17 
Minute,58 
Second,34 

• The launch observation data may be provided in lines labeled with the parameter 
name. 

• To designate a dropsonde sounding, include a line:  
Ascending,"false" 

• A “Fields” line defines the data fields and their order, for the succeeding “Data” 
lines. Aspen output CSV files will contain a fairly large number of fields, e.g.: 
Fields,Time,Pressure,Temperature,RH,Speed,Direction,Latitude, \ 
Longitude,Altitude,Dewpoint,Uwnd,Vwnd,Ascent 

• For an input CVS file to be read properly by Aspen, the following data field 
conventions must be followed: 

Fields Aspen utilization 

time 
pressure 

These are required input data fields. 

rh 
rh1 
rh2 
speed 
direction 
latitude 
longitude 
altitude 
ascent 
sats 
gpsalt 

These data fields will be utilized, if provided. 

others Other data fields will be ignored on input. 

• The “Units” lines documents the units of each data field. Note that the units 
shown here must be adhered to; Aspen will not make units conversions. At least 
the time and pressure fields must be provided: 

Units,sec,mb,deg C,%,m/s,deg,deg,deg,m,deg C,m/s,m/s,m/s 
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• The “Data” lines follow after all of the preceeding records. 

Some other rules apply: 
• Long strings should be enclosed in quotes. 
• Don’t include commas in strings 

• Capitalization is not important. 
• The data series must be ordered in time 

• Time tags less than zero will be ignored 
• Don’t use reserved strings in the first field of a line. 

• “Fields” must come before “Data” 
• Missing data are simply represented by empty fields, i.e. two commas in 

succession, or a trailing comma on the end of a line, indicating that the last field is 
missing. 

The following demonstrates a small CSV file (note that the line breaks are not found in 
the actual file): 
FileFormat,CSV 
Year,2001 
Month,08 
Day,01 
Hour,17 
Minute,58 
Second,34 
Pressure,57.6,"units=mb" 
Temperature,-59.9,"units=deg C" 
RH,,"units=%" 
Speed,7.9,"units=m/s" 
Direction,92.0,"units=deg" 
Latitude,30.9909,"units=deg" 
Longitude,-119.5005,"units=deg" 
Altitude,19610.0,"units=m" 
Ascending,"false" 
Fields,Time,Pressure,Temperature,RH,Speed,Direction,Latitude,Longitude,
Altitude,Dewpoint,Uwnd,Vwnd,Ascent 
Units,sec,mb,deg C,%,m/s,deg,deg,deg,m,deg C,m/s,m/s,m/s 
Data,0.3,,,,,,,,,,,, 
Data,0.8,,,,,,,,,,,, 
Data,11.8,,,,11.52,69.53,,,,,-10.79,-4.03, 
Data,38.8,71.06,-60.33,,8.23,104.25,30.99129,-119.50375,18295.7,,-
7.98,2.03,-39.94 
Data,51.8,77.01,-63.75,,8.67,160.11,30.99174,-119.50441,17799.7,,-
2.95,8.15,-36.35 
Data,66.3,83.86,-62.29,,,,30.99267,-119.50520,17276.1,,,,-35.06 
Data,75.8,88.52,-64.99,,8.95,119.15,30.99295,-119.50592,16944.3,,-
7.82,4.36,-34.01 
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Appendix C: System Requirements 

Screen resolution: 1024x768 pixels or greater 

Windows display: configured for small fonts 
Free disk space: at least 20 MB  

Processor speed: 500 MHz or better recommended 
System memory: 256 MB RAM or greater 

Operating system: Windows XP 
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Appendix D: netCDF Attributes 

The following shows the output of an ncdump command applied to an Aspen generated 
netCDF  file.  
netcdf D20010801_175834QC { 
dimensions: 
 time = 2122 ; 
variables: 
 int base_time ; 
  base_time:long_name = "sounding launch time" ; 
  base_time:units = "seconds since 1970-01-01 00:00:00 UTC" ; 
  base_time:string = "Wed Aug 01 17:58:34 2001" ; 
 float time_offset(time) ; 
  time_offset:long_name = "seconds since base_time" ; 
  time_offset:units = "seconds" ; 
  time_offset:missing_value = -999.f ; 
  time_offset:_FillValue = -999.f ; 
 double time(time) ; 
  time:long_name = "time" ; 
  time:units = "seconds since 1970-01-01 00:00:00 UTC" ; 
  time:missing_value = -999.f ; 
  time:_FillValue = -999. ; 
 float pres(time) ; 
  pres:long_name = "pres" ; 
  pres:units = "hPa" ; 
  pres:missing_value = -999.f ; 
  pres:field_type = "P" ; 
  pres:_FillValue = -999.f ; 
 float tdry(time) ; 
  tdry:long_name = "tdry" ; 
  tdry:units = "degC" ; 
  tdry:missing_value = -999.f ; 
  tdry:field_type = "T" ; 
  tdry:_FillValue = -999.f ; 
 float dp(time) ; 
  dp:long_name = "dp" ; 
  dp:units = "degC" ; 
  dp:missing_value = -999.f ; 
  dp:field_type = "T_d" ; 
  dp:_FillValue = -999.f ; 
 float rh(time) ; 
  rh:long_name = "rh" ; 
  rh:units = "percent" ; 
  rh:missing_value = -999.f ; 
  rh:field_type = "rh" ; 
  rh:_FillValue = -999.f ; 
 float u_wind(time) ; 
  u_wind:long_name = "u_wind" ; 
  u_wind:units = "m/s" ; 
  u_wind:missing_value = -999.f ; 
  u_wind:field_type = "uwind" ; 
  u_wind:_FillValue = -999.f ; 
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 float v_wind(time) ; 
  v_wind:long_name = "v_wind" ; 
  v_wind:units = "m/s" ; 
  v_wind:missing_value = -999.f ; 
  v_wind:field_type = "vwind" ; 
  v_wind:_FillValue = -999.f ; 
 float wspd(time) ; 
  wspd:long_name = "wspd" ; 
  wspd:units = "m/s" ; 
  wspd:missing_value = -999.f ; 
  wspd:field_type = "wspd" ; 
  wspd:_FillValue = -999.f ; 
 float wdir(time) ; 
  wdir:long_name = "wdir" ; 
  wdir:units = "degree" ; 
  wdir:missing_value = -999.f ; 
  wdir:field_type = "wdir" ; 
  wdir:_FillValue = -999.f ; 
 float dz(time) ; 
  dz:long_name = "dz" ; 
  dz:units = "m/s" ; 
  dz:missing_value = -999.f ; 
  dz:_FillValue = -999.f ; 
 float range(time) ; 
  range:long_name = "range" ; 
  range:units = "km" ; 
  range:missing_value = -999.f ; 
  range:_FillValue = -999.f ; 
 float qp(time) ; 
  qp:long_name = "qp" ; 
  qp:units = "hPa" ; 
  qp:missing_value = -999.f ; 
  qp:_FillValue = -999.f ; 
 float qt(time) ; 
  qt:long_name = "qt" ; 
  qt:units = "degC" ; 
  qt:missing_value = -999.f ; 
  qt:_FillValue = -999.f ; 
 float qrh(time) ; 
  qrh:long_name = "qrh" ; 
  qrh:units = "percent" ; 
  qrh:missing_value = -999.f ; 
  qrh:_FillValue = -999.f ; 
 float qu(time) ; 
  qu:long_name = "qu" ; 
  qu:units = "m/s" ; 
  qu:missing_value = -999.f ; 
  qu:_FillValue = -999.f ; 
 float qv(time) ; 
  qv:long_name = "qv" ; 
  qv:units = "m/s" ; 
  qv:missing_value = -999.f ; 
  qv:_FillValue = -999.f ; 
 float qwind(time) ; 
  qwind:long_name = "qwind" ; 
  qwind:units = "m/s" ; 
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  qwind:missing_value = -999.f ; 
  qwind:_FillValue = -999.f ; 
 float mr(time) ; 
  mr:long_name = "mr" ; 
  mr:units = "gram/kg" ; 
  mr:missing_value = -999.f ; 
  mr:_FillValue = -999.f ; 
 float vt(time) ; 
  vt:long_name = "vt" ; 
  vt:units = "degC" ; 
  vt:missing_value = -999.f ; 
  vt:_FillValue = -999.f ; 
 float theta(time) ; 
  theta:long_name = "theta" ; 
  theta:units = "K" ; 
  theta:missing_value = -999.f ; 
  theta:_FillValue = -999.f ; 
 float theta_e(time) ; 
  theta_e:long_name = "theta_e" ; 
  theta_e:units = "K" ; 
  theta_e:missing_value = -999.f ; 
  theta_e:_FillValue = -999.f ; 
 float theta_v(time) ; 
  theta_v:long_name = "theta_v" ; 
  theta_v:units = "K" ; 
  theta_v:missing_value = -999.f ; 
  theta_v:_FillValue = -999.f ; 
 float lat(time) ; 
  lat:long_name = "north latitude" ; 
  lat:units = "degrees" ; 
  lat:missing_value = -999.f ; 
  lat:_FillValue = -999.f ; 
  lat:valid_range = -90.f, 90.f ; 
 float lon(time) ; 
  lon:long_name = "east longitude" ; 
  lon:units = "degrees" ; 
  lon:missing_value = -999.f ; 
  lon:_FillValue = -999.f ; 
  lon:valid_range = -180.f, 180.f ; 
 float alt(time) ; 
  alt:long_name = "altitude above MSL" ; 
  alt:units = "meters" ; 
  alt:missing_value = -999.f ; 
  alt:_FillValue = -999.f ; 
 
// global attributes: 
  :bad_value_flag = -999.f ; 
  :zebra_platform = "class" ; 
  :history = "ClassNcFile" ; 
  :AvapsEditorVersion = "2.3.1" ; 
  :SoundingDescription = "D20010801_175834.3 011118097 AAVAPS 
Flight Test, EAFB Flight Test 3 Lockheed ER-2, NASA 809" ; 
  :ACagency = "AF001" ; 
  :ACtype = "0" ; 
  :AbrHdrOvr = "0" ; 
  :AutoFile = "1" ; 
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  :BSN = "99999" ; 
  :BaudRateIndex = "2" ; 
  :CallSign = "CALL" ; 
  :ChuteArea = "676" ; 
  :CommPortIndex = "0" ; 
  :DoLevels = "1" ; 
  :DoQC = "1" ; 
  :DoWMO = "1" ; 
  :DropSondeMass = "395" ; 
  :DropsondeHitSfc = "1" ; 
  :ExcludeAbrHdr = "0" ; 
  :IcaoIndex = "1" ; 
  :MissionId = "TRAIN" ; 
  :MissionStorm = "WXWXA" ; 
  :OptIcao = "W" ; 
  :PlotFileFormat = "0" ; 
  :PlotPixelsX = "1000" ; 
  :PlotPixelsY = "700" ; 
  :PosInterpSpan = "60" ; 
  :PresBuddySlope = "2" ; 
  :PresOffset = "0" ; 
  :PresOutlier = "10" ; 
  :PresQCDev = "3" ; 
  :PresQCWL = "10" ; 
  :PresSmoothWL = "5" ; 
  :QCSaveDir = "C:\\tmp\\ER-2" ; 
  :RHBuddySlope = "20" ; 
  :RHOffset = "0" ; 
  :RHOutlier = "10" ; 
  :RHQCDev = "3" ; 
  :RHQCWL = "10" ; 
  :RHSmoothWL = "5" ; 
  :RHchoice = "0" ; 
  :RawSaveDir = "C:/" ; 
  :SetHtsMissing = "0" ; 
  :SfcAltUnknown = "1" ; 
  :SfcAltitude = "0" ; 
  :SkewTPlotSaveDir = "C:/" ; 
  :TdryBuddySlope = "3" ; 
  :TdryDynCor = "0" ; 
  :TdryOffset = "0" ; 
  :TdryOutlier = "10" ; 
  :TdryQCDev = "3" ; 
  :TdryQCWL = "10" ; 
  :TdrySmoothWL = "5" ; 
  :TempMsgType = "0" ; 
  :WindBuddySlope = "5" ; 
  :WindDynCor = "0" ; 
  :WindOutlier = "10" ; 
  :WindQCDev = "3" ; 
  :WindQCWL = "10" ; 
  :WindSats = "3" ; 
  :WindSmoothWL = "10" ; 
  :WindVVdelta = "2.5" ; 
  :WmoSaveDir = "C:/" ; 
  :XYPlotSaveDir = "C:\\tmp" ; 
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